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Chapter 10: Staff Tool

Staff Tool 
What it does
The Staff Tool creates and deletes staves. It also lets you drag existing staves up or down on the 
screen, so that you can view any two staves together.

You use the Staff Tool to select staves, too—for example, to specify the staves you want displayed 
when you create a Staff Set (see HIDING STAVES). You also use it to select staves you want to 
extract using the Special Part Extraction feature (see EXTRACTING PARTS). And you can use it to 
move, regroup, or rebracket staves in Page View that have been optimized (see OPTIMIZING SYS-

TEMS).

Finally, you can use this tool to group staves—to connect their barlines and add brackets, if you 
wish (see GROUPS). Remember that the mouse clicks listed below generally work only in Scroll 
View.

A Staff menu appears when you click the Staff Tool; the Staff Menu contains a wide-ranging set 
of commands for working with staves and groups of staves—adding, deleting, positioning and 
spacing staves, creating customized staff attributes, defining groups of staves, adding brackets and 
piano braces, and so on. 

Finale’s group editing ability gives you flexibility in assigning staves to groups and setting up 
group attributes such as bracket and barline display. Staves can belong to more than one group.

Special mouse clicks
Many of the Staff Menu commands also have shortcuts. 

Staff handles always appear on staves in the score, even on staves that are hidden.

For staff handles and staves

Shortcut What it does

Click the Staff Tool Display handles on each staff. The Staff Menu appears.

Click a staff handle, or drag-enclose staff handles Select a staff (or staves).

Shift-click a staff handle Add the staff to the selection. If a staff is already selected, remove 
the staff from the selection.

Double-click a staff or a staff handle, or right-click the 
handle and select Edit Staff Attributes from the con-
textual menu

Edit the staff’s attributes. The Staff Attributes dialog box appears.

Double-click in the score (in Scroll View) Add a staff without repositioning the lower staves to make room for 
the new staff.

Shift-double-click below a staff in the score (in Scroll 
View)

Insert a staff between staves, repositioning the lower staves to make 
room for the new staff.
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Ctrl-shift-click a staff or staff handle in one or more 
selected staves, or right-click the handle and select 
Add Group and Bracket from the contextual menu

Create a new group for the selected staves. The Group Attributes 
dialog box appears.

Press delete for selected staves, or right-click the han-
dle and select Delete Staves from the contextual menu. 
Note: If a staff system has been optimized using the 
Page Layout Tool, two handles will appear on each 
staff in the optimized staff system.

Delete the selected staves without repositioning the remaining 
staves.

Press shift-delete for selected staves, or right-click the 
handle and select Delete Staves and Reposition from 
the contextual menu. Note: If a staff system has been 
optimized using the Page Layout Tool, two handles 
will appear on each staff in the optimized staff system.

Delete the selected staves and reposition the remaining staves.

Select the bottom staff handle or handles in Page View 
and press delete for selected staves, or right-click the 
handle and select Delete Staves from the contextual 
menu. Note: This will remove the optimized staff from 
the system regardless of whether it contains music.

Delete the selected staves for that system only without reposition-
ing the remaining staves.

Select the bottom staff handle or handles in Page View 
and press shift-delete for selected staves, or right-click 
the handle and select Delete Staves and Reposition 
from the contextual menu. Note: This will remove the 
optimized staff from the system regardless of whether 
it contains music.

Delete the selected staves for that system only and reposition the 
remaining staves.

Drag a staff handle in Scroll View (when Special Part 
Extraction is not selected in the Edit Menu)

Adjust the staff’s position in Scroll View and every staff system in 
Page View. Note: The horizontal adjustment affects the placement 
of the staves in Scroll View only; it does not affect printout or the 
display in Page View.

Drag a staff handle in Scroll View (when Special Part 
Extraction is selected in the Edit Menu)

Adjust the staff’s position in Scroll View only. The placement of 
staves remains unchanged in Page View. (When you choose Special 
Part Extraction from the Edit Menu, Finale removes the checkmark 
by the command, and displays the full score using the new position-
ing in Scroll View.)

Drag a staff handle in Page View (when Special Part 
Extraction is not selected in the Edit Menu). Note: If 
two handles appear on a staff, drag the top handle

Adjust the staff’s position in every staff system in Page View and 
the position of the staff in Scroll View. When the top staff is 
adjusted, Finale adjusts the distance between staves, as well as staff 
systems.

Drag a staff handle in Page View (when Special Part 
Extraction is selected in the Edit Menu). Note: If two 
handles appear on a staff, drag the top handle

Adjust the staff’s position in every staff system in Page View; leave 
the position of the staff unchanged in Scroll View. Finale adjusts the 
distance between staves, as well as staff systems.

Drag the bottom staff handle in Page View. Note: If a 
staff system has been optimized using the Page Layout 
Tool, two handles will appear on each staff in the opti-
mized staff system.

Adjust the staff’s position only in the current staff system (drag the 
top handle to adjust the position of the staff in all staff systems in 
Page View).

Hold down backspace while clicking on a staff with 
Staff Styles or on the Style Bar.

Removes the selected Staff Style from the selected region.

Double-click on a Staff Style bar Displays the selected Staff Styles dialog box

For staff handles and staves

Shortcut What it does
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Group handles always appear on existing groups of staves in the score, even if you did not enter 
a group name. You can display Finale’s default names for unnamed groups. To show or hide 
default group names in the score, use the Show Default Group Names command in the Staff Menu 
(see STAFF MENU).

Finale displays staff name handles on existing staves in the score only if you have entered a staff 
name, or if Finale’s default staff name appears for an unnamed staff. To show or hide default staff 
names for unnamed staves, use the Show Default Staff Names command in the Staff Menu (see 
STAFF MENU). If you want Finale to show staff name handles on unnamed staves, you must select 
Show Default Staff Names.

For group handles

Shortcut What it does

Click a group handle, or drag-enclose group handles Select a group (or groups).

Shift-click a group handle Add the group to the selection. If a group is already selected, 
remove the group from the selection.

Double-click a group handle, or right-click the handle 
and select Edit Group Attributes from the contextual 
menu

Edit the group’s attributes. The Group Attributes dialog box 
appears.

Ctrl-click a group handle, or right-click the handle and 
select Edit Full Group Name or Edit Abbreviated Group 
Name from the contextual menu

Edit a group name. The Edit Text window appears.

Ctrl-shift-click a group handle, or right- click the handle 
and select Position Full Group Name or Position Abbre-
viated Group Name from the contextual menu

Position a group name. The Position Full Group Name or Position 
Abbreviated Group Name dialog box appears.

Press backspace for selected groups Revert the position of the group names to their default position.

Press delete for selected groups, or right-click the han-
dle and select Delete Group from the contextual menu

Remove the selected group definitions.

Drag a group handle Adjust the position of a group name.

For staff name handles

Shortcut What it does

Click a staff name handle, or drag-enclose staff name 
handles

Select a staff name (or names).

Shift-click a full or abbreviated staff name handle Add the staff name to the selection. If a staff name is already 
selected, remove the staff name from the selection.

Double-click a full or abbreviated staff name handle, or 
right-click the handle and select Edit Staff Attributes 
from the contextual menu

Edit the staff’s attributes. The Staff Attributes dialog box appears.

Ctrl-click a full or abbreviated staff name handle, or 
right-click the handle and select Edit Full Staff Name or 
Edit Abbreviated Staff Name from the contextual menu

Edit a full or abbreviated staff name. The Edit Text window 
appears for the selected name.

Ctrl-shift-click a full or abbreviated staff name handle, 
or right-click the handle and select Position Full Staff 
Name or Position Abbreviated Staff Name from the con-
textual menu

Position the selected staff name. The Position Full Staff Name or 
Position Abbreviated Staff Name dialog box appears.



 

Staff Tool 10-4      

OC

OC

ndex

Index

ext 
hapter

ext 
hapter

revious
hapter

revious
hapter

          
T

T

I

N
C

N
C

P
C

P
C

Two bracket handles appear on each bracket on a group, even if you did not enter a group name.

Press backspace for a selected staff name handle Revert the position of the full or abbreviated staff name to its 
default position.

Drag a full or abbreviated staff name handle Adjust the position of the selected staff name.

For bracket handles

Shortcut What it does

Click a bracket handle, or drag-enclose several bracket 
handles

Select a bracket (or brackets).

Shift-click a bracket handle Add the bracket to the selection. If a bracket is already selected, 
remove the bracket from the selection.

Double-click a bracket handle, or right-click the handle 
and select Edit Group Attributes from the contextual 
menu

Edit a group. The Group Attributes dialog box appears.

Press delete for selected brackets, or right-click the han-
dle and select Delete Bracket from the contextual menu

Remove the selected brackets.

Press backspace for selected brackets Revert the selected brackets to their default length.

Drag a bracket handle vertically Make a bracket taller or shorter.

Drag a bracket handle horizontally Move a bracket closer to or away from bracketed staves.

For staff name handles

Shortcut What it does
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Contextual menus
Contextual menus are reached by right-clicking on the handle of an object. A contextual menu 
will be displayed where you can select various items.

Staff handles

Menu item What it does

Edit Staff Attributes Display Staff Attributes dialog box

Add Group and Bracket Display Group Attributes dialog box

Select Clef Display Clef Selection dialog box

Edit Full Staff Name Display the Edit Text dialog box for Full Staff Name

Edit Abbreviated Staff Name Display the Edit Text dialog box for Abbreviated Staff Name

Delete Staves Deletes selected staves

Delete Staves and Reposition Deletes selected staves and repositions remaining staves

Staff Style bars

Menu item What it does

Edit Selected Staff Style Displays the Staff Style dialog box for the selected style

Clear Selected Staff Style Removes selected Staff Style from selected region

Staff regions

Menu item What it does

Define Staff Style Displays the Staff Style dialog box

Apply Staff Style Displays the Apply Staff Style dialog box

Clear Staff Style Removes any Staff Styles present

List of currently created staff styles Applies the selected staff style from the list

Full Staff Name handles

Menu item What it does

Edit Staff Attributes Display Staff Attributes dialog box

Edit Full Staff Name Display the Edit Text dialog box for Full Staff Name

Position Full Staff Name Display the Position Full Staff Name dialog box

Abbreviated Staff Name handles

Menu item What it does

Edit Staff Attributes Display Staff Attributes dialog box

Edit Abbreviated Staff Name Display the Edit Text dialog box for Abbreviated Staff Name

Position Abbreviated Staff Name Display the Position Abbreviated Staff Name dialog box

Full Group Name handles

Menu item What it does

Edit Group Attributes Display Group Attributes dialog box
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Metatools
You can create Staff Style Metatools—one-keystroke equivalents for staff styles—which can be 
especially useful if you apply the same staff style in multiple places in your score. All of the staff 
styles included in your default file have already been programmed with metatools. See FINALE 
LIBRARIES for more details.

To program a Staff Style Metatool
Click the Staff Tool. Press shift and a number key or a letter. Finale displays the Apply Staff Style 
dialog box; choose the staff style you want to correspond to the number or letter you pressed. 
Click OK (or press enter).

To use a Staff Style Metatool
Click the Staff Tool. Select a region. Press the number or letter corresponding to the Metatool you 
programmed. Finale applies the staff style over the range or measures you selected.

Staff Menu
How to get there

Click the Staff Tool s.

What it does
Use the Staff Menu to add or insert blank staves into the score, remove existing staves, position 
staff names, change the settings for a selected staff, adjust staves vertically, redraw barlines and 
brackets after changing the top-to-bottom order of staves in the score, and set the spacing between 
staves. You can also create groups and define their characteristics, delete groups, choose a bracket 
and alternate barlines for a group, and change which staves belong to a group.

Edit Full Group Name Display the Edit Text dialog box for Full Group Name

Position Full Group Name Display the Position Full Group Name dialog box

Delete Group Deletes selected group

Abbreviated Group Name handles

Menu item What it does

Edit Group Attributes Display Group Attributes dialog box

Edit Abbreviated Group Name Display the Edit Text dialog box for Abbreviated Group Name

Position Abbreviated Group Name Display the Position Abbreviated Group Name dialog box

Delete Group Deletes selected group

Bracket handles

Menu item What it does

Edit Group Attributes Display Group Attributes dialog box

Delete Bracket Deletes selected bracket

Full Group Name handles

Menu item What it does
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• New Staves • New Staves (with Setup Wizard). Choose New Staves when no staves are 
selected to add new blank staves below the existing staves in your score. To insert blank staves 
above a particular staff, select a staff or staves in the score, then choose New Staves. The New 
Staves dialog box appears, in which you enter the number of staves to be added or inserted, 
and how far apart Finale should space them. New Staves (with Setup Wizard) allows you to 
add new staves using the wizard which will name the staves and set up the instrument patch 
and transposition as well.

Tip: The distance between staves is subject to any resizing you do with the Resize Tool.
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• Delete Staves • Delete Staves and Reposition. These commands are only available when one 
or more staves are selected. Select the staff or staves that you want removed from the score, 
then choose either command. Choose Delete Staves to remove the selected staves and leave 
the remaining staves in their current positions. Choose Delete Staves and Reposition to 
remove the selected staves and reposition any staves that were below the deleted staves. Finale 
moves the remaining staves up to the position of the top staff that was deleted. 

Note: Only delete staves if you want them permanently removed from your score. To recover 
deleted staves, immediately choose Undo from the Edit Menu. To temporarily remove a staff, 
such as an ossia staff, hide the staff using the Hide Staves checkbox in the Staff Attributes dia-
log box. See HIDING STAVES—To hide staves for ossia measures or special playback.

• Edit Staff Attributes. Select a staff, then choose this command. Or, choose this command 
with no staff selected.The Staff Attributes dialog box appears, displaying the attributes for the 
selected staff or the first staff, respectively. Here you can change the settings for the displayed 
staff. For details, see STAFF ATTRIBUTES DIALOG BOX.

• Respace Staves. Choose this command to display the Respace Staves dialog box, in which 
you can restore all the staves in your score to uniform vertical spacing, or, if they weren’t 
evenly spaced to begin with, you can preserve the gap between staves and make all gaps pro-
portionally larger or smaller. For details, see RESPACE STAVES DIALOG BOX.

• Sort Staves. If you’ve changed the top-to-bottom order of staves in the score by dragging 
them, you may notice that the left barline of the score or the brackets sometimes appear to be 
broken or uneven afterward. Choose Sort Staves to restore their appearance based on the new 
staff order. This option does not re-number the staves.

• Auto Sort Staves. Check this option to have Finale automatically resort the top-to-bottom 
order of staves in the score. This option does not re-number the staves.

• Staff Usage. Choose this command to display the Staff Usage List dialog box, in which you 
can specify the exact vertical position of a staff or staves in the score. See STAFF USAGE LIST 
DIALOG BOX.

• Define Staff Styles. Choose this command to create and edit staff styles in the staff styles dia-
log box. A staff style is a set of staff attributes that can be saved and applied to parts of a staff 
at different points. When any of the attributes of the staff style is changed (such as the staff 
name or transposition) all areas of the score that have that staff style applied are also changed. 
See STAFF STYLES DIALOG BOX and STAFF STYLES.

• Clear Staff Styles. Choose this command to remove any staff styles applied to the currently 
selected region.

• Apply Staff Styles. Choose this command to display the Apply Staff Styles dialog box. This 
dialog box lists all the currently defined staff styles available.  Select a staff style to apply to 
the selected region. See APPLY STAFF STYLE DIALOG BOX.

• Show Staff Styles. Choose this command to show (or hide) the staff style markers in the 
staves. The markers appear as a bar above measures where staff styles have been applied. Tip: 
double-click on the marker bar to edit the staff style.

• Show Staff Style Names. Choose this command to show (or hide) the name of the staff style 
above the measures where staff styles have been applied. This command is only available 
when Show Staff Styles is checked.
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• Add Group and Bracket. Choose this command to display the Group Attributes dialog box, 
where you can create and control the appearance of groups. Choose which consecutive staves 
you want included in the group, name the group, choose an alternate barline, and choose a 
bracket to enclose them. You can also control how barlines appear. For details, see GROUP 
ATTRIBUTES DIALOG BOX.

• Edit Group Attributes. Select a handle for a group in the score, then choose this command to 
display the Group Attributes dialog box, in which you can change which staves belong to the 
selected group, and choose a different bracket and barline. For details, see GROUP 
ATTRIBUTES DIALOG BOX.

• Remove Group. Select a group handle or handles (to delete more than one staff group), then 
choose this command to remove the selected group definitions from the score.

• Set Default Name Positions: Full Staff Names • Abbreviated Staff Names • Full Group 
Names • Abbreviated Group Names. Choose Full Staff Names or Abbreviated Staff Names 
from the Set Default Name Positions submenu to set up the default position and alignment for 
all full or all abbreviated staff names in the score, respectively. The Position Full Staff Name--
Default or Position Abbreviated Staff Name--Default dialog box appears, where you can 
adjust the position of the staff name, relative to the staff. The default positioning will be used 
unless you change the position of an individual staff name in the score. For details, see POSI-

TION AND ABBREVIATED STAFF NAMES DIALOG BOXES.
Choose Full Group Names or Abbreviated Group Names from the Set Default Name Positions 
submenu to set up the default position and alignment for all full or all abbreviated group 
names in the score, respectively. The Position Full Group Name--Default or Position Abbrevi-
ated Group Name--Default dialog box appears, where you can set up the default position and 
alignment for all group names in the score. By default, Finale vertically centers group names 
between the first and last staves in the group (from the top line of the first staff, to the bottom 
line of the last). The default positioning will be used unless you change the position of a spe-
cific group name in the score. For details, see POSITION FULL AND ABBREVIATED GROUP 
NAMES DIALOG BOXES.

• Position Names: Full Staff Names • Abbreviated Staff Names • Full Group Names • 
Abbreviated Group Names. To adjust the position of an individual staff name, select the staff 
name’s handle, then choose Full Staff Names or Abbreviated Staff Names from the Position 
Names submenu. The Position Full Staff Name or Position Abbreviated Staff Name dialog 
box appears, where you can adjust the position of the staff name, relative to the staff. Or, sim-
ply drag the staff name handle to adjust the position on-screen. For details, see POSITION FULL 
AND ABBREVIATED STAFF NAMES DIALOG BOXES.
To adjust the position of an individual group name, select the group’s handle, then choose Full 
Group Names or Abbreviated Group Names from the Position Names submenu. The Position 
Full Group Name or Position Abbreviated Group Name dialog box appears, where you can 
adjust the position of the group name, which is vertically centered between the first and last 
staves in the group. Or, simply drag the group handle to adjust the position on-screen. For 
details, see POSITION FULL AND ABBREVIATED GROUP NAMES DIALOG BOXES.
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Note: When you change the individual position of a staff or group name by dragging the name 
on-screen or by using a Position command, Finale automatically selects the Position checkbox 
in the Staff Attributes dialog box or the Group Attributes dialog box. This means that the spe-
cial positioning will apply only to this staff name or group name wherever it appears in the 
score. To use the global, default positioning for the name, click the Position checkbox in the 
Staff Attributes dialog box or the Group Attributes dialog box to remove the selection. Or, 
simply select the staff name handle or group handle on-screen, and press backspace.

• Show Default Staff Names. This command displays Finale’s default names and staff name 
handles for unnamed staves. The default staff names appear on the screen, enclosed in square 
brackets. Default names can help you identify staff handles. They will never appear in printed 
copies of the score; staff names that you enter are the only names that appear in your printed 
music. This command must be selected if you want staff name handles to appear on unnamed 
staves in your score. Deselect this command if you don’t want default staff names or default 
staff name handles to appear on-screen.

• Show Default Group Names. This command displays Finale’s default names for unnamed 
groups. Default group names only appear on the screen, enclosed in square brackets; they will 
never appear in printed copies of the score. Group names which you enter are the only names 
that appear in your printed music. Deselect this command if you don’t want Finale’s default 
group names to appear on-screen. Regardless of whether this command is selected, Finale will 
always show group handles on-screen.

New Staves dialog box
How to get there

Click the Staff Tool s. Choose New Staves from the Staff Menu to add staves to the bottom of 

your score.

Or, click the Staff Tool, then click a staff handle. Choose Add Staves from the Staff Menu to insert 
staves before the selected staff or staves in your score.

What it does
The New Staves dialog box contains settings for the number of new blank staves to be added 
below the bottom-most staff, or inserted above a selected staff, as well as how far apart they 
should be placed.
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• Number of Staves. Enter the number of new blank staves you want added below the existing 
staves or inserted above the selected staff in the score.

• Topline to Topline Distance. This is the distance between the new staves (in currently 
selected measurement units), measured from the top line of one staff to the top line of the next. 
Enter a value to place the new staves closer or farther apart than they already are in the score. 
You’ll usually want to enter a negative number, because you’re measuring down from the top 
line of the previous staff.

Note: Finale always measures Topline to Topline Distance from the top line of a standard, 5-
line staff. To locate Finale’s “Topline” position on staves with fewer than five lines (such as 
percussion staves), look for the staff handle; it always indicates the top line position.

• OK • Cancel. Click Cancel to return to the score without adding staves. Click OK (or press 
enter) to add staves and return to the score.

Staff Attributes dialog box
How to get there

Click the Staff Tool s. Choose Edit Staff Attributes from the Staff Menu. Or, double-click a 

staff handle, or a staff name handle.

What it does
In the Staff Attributes dialog box, you can specify dozens of staff-specific traits for the staff whose 
handle you clicked, including its name, transposition, and clef. You can also tell Finale whether or 
not certain musical elements should appear in this staff—measure numbers, default whole rests, 
time signatures, and repeat ending brackets, to name a few. 

You can create and edit full and abbreviated staff names mixing fonts and styles (see TEXT). You 
can also allow or prevent optimization of the current staff. See also GLOBAL STAFF ATTRIBUTES 
plug-in.
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• Staff Attributes for: Arrow controls. These arrows appear to the right of the staff name drop-
down list, making it easy for you to move consecutively through the staves to select staff 
attributes. Click the arrows to change staves instead of choosing a new staff name from the 
drop-down list.

• Full Name • Edit; Abbr. Name • Edit. The full or abbreviated names you enter for the staff 
appear in a regular text font. Click the Edit button to display the Edit Text window, where you 
can enter or edit the full or abbreviated staff name and set fonts and text styles. See EDIT TEXT 
WINDOW.

• Full Name • Position. It’s important to understand that you establish the position for staff 
names globally using the Set Default Name Position command in the Staff Menu. Use the 
Position button here only to override the global position for this particular staff.

To do so, click the Position checkbox, then click Position, to display the Position Full Staff 
Name dialog box (see POSITION FULL AND ABBREVIATED STAFF NAMES DIALOG BOXES.)
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• Abbr. Name • Position. Here, too, you should realize that you set the global position for staff-
name abbreviations using the Set Default Name Position command. Use the Position check-
box and button here only to override the global position for this particular staff.

• First Clef • Select. This display identifies the clef that will appear at the beginning of the staff. 
To change this clef, click Select. The Clef Selection dialog box appears, displaying Finale’s 
sixteen default clefs. Double-click the one you want; you return to the Staff Attributes dialog 
box, where Finale displays the clef you clicked.

• Alternate Notation • Select. Use this checkbox and select button to set alternate notation for 
the entire staff. See ALTERNATE NOTATION DIALOG BOX.

• Transposition • Select. If the instrument whose staff you’re establishing is a transposing 
instrument (such as a trumpet or clarinet), select Transposition, then click the Select button. 
The Staff Transpositions dialog box appears, in which you can specify the interval by which 
you want the music on the staff to be automatically transposed. See STAFF TRANSPOSITIONS 
DIALOG BOX. To make the staff non-transposing again, click the checkbox again to deselect it.

Once you’ve established the transposing instruments’ staves, you can tell Finale to display the 
full score either in its transposed form or in its untransposed (concert pitch) form. Choose Dis-
play in Concert Pitch from the Options Menu to show the score untransposed.

The staves in the full score always print out exactly as they appear on the screen (whether 
transposed or in concert pitch); when you extract parts, however, the resultant parts are printed 
in their transposed form. (The exception is the Special Part Extraction method of extracting 
parts, which will print staves transposed or not according to your Display score in concert 
pitch setting.)

For a more complete discussion of transposing instruments, see TRANSPOSING INSTRUMENTS.

• Staff: Standard 5-line • 1-line with Full Barline • 1-line with Short Barline • 0-line with 
Full Barline • Other. Choose from four commonly-used staves, or choose Other to display 
the Staff Setup dialog box, in which you can specify a custom staff. See STAFF SETUP DIALOG 
BOX.

• Allow Optimization. Use this option to control whether Finale will remove the staff during 
the optimization process. (When you optimize a score using the Page Layout Tool, Finale 
hides resting instruments on each staff system.) Click to select this checkbox if you want to 
allow Finale to hide this staff (if it contains no music) in optimized staff systems. Deselect the 
checkbox to prevent Finale from hiding the staff; the staff will appear, even if it contains no 
music. For example, select this option for the Treble and Bass staves of piano staves, since 
scores usually display both staves of piano parts, even when other parts drop out.

• Break barlines between staves • Break repeat barlines between staves. Normally, when 
you group some staves together, the barlines are drawn continuously through them (including 
the blank spaces between them). Select “Break Barlines Between Staves” if you want bar-
lines—both normal and repeat barlines—not to continue through to the next staff above this 
one. (If this staff isn’t part of a staff group, you won’t notice any difference. You group staves 
by selecting their handles with the Staff Tool and double-clicking one of the selected handles. 
See GROUPS.)
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Select “Break Repeat Barlines Between Staves” if you want to break repeat barlines that 
would normally continue through to the next staff above this one. This option doesn’t affect 
normal barlines.

• Display rests in empty measures. To save you time, Finale normally draws a default whole 
rest in every blank measure. Deselect this checkbox if you don’t want Finale to draw these 
“false” whole rests for this staff. You might wish to suppress them if, for example, you simply 
want to print out blank score paper.

• Flat Beams. Select this option to force all the beams in the staff to draw flat instead of at an 
angle.

• Hide Staff. Select this option to hide the current staff. Use this control when you want to hide 
a staff used for ossia measure source staves, or if you’ve created a staff that contains playback 
effects such as written out trills or tremolos.   The word “(hidden)” appears in Staff Lists next 
to the staff name for any staves that are hidden.

• Ignore Key Signatures. Finale retains this setting for compatibility with older version files. 
Select this option if you want Finale to transpose all the notes in the staff to the key of C for 
the entire piece, regardless of any key changes that occur.

• Independent Elements: Key Signature • Time Signature • Notehead Font; Select. “Inde-
pendent” means that these elements are allowed to vary from staff to staff. These options let 
you specify key signatures, time signatures, music font, or notehead shapes for each staff inde-
pendently.

For example, click Key Signature or Time Signature if you want this staff to be in a different 
key or meter than the other staves in the piece. When you click the Key Signature or Time Sig-
nature Tool, a handle appears on every barline of each staff for which you’ve selected Key Sig-
nature or Time Signature. Click the handle to access the Key Signature or Time Signature 
dialog box for that staff alone.

You can choose any font for your noteheads without affecting flags, rests, and accidentals on 
the notes in the staff. When the Notehead Font checkbox is selected, Finale uses the font you 
select for the current staff. When this checkbox is not selected, Finale uses the font specified 
in Document Options-Fonts. Click Select to display the Font dialog box. The Maestro Percus-
sion font included with Finale contains noteheads for use on percussion staves, as well as 
noteheads to use for hymnals requiring shape notes. For details, refer to FONTS.

• Items to Display: Augmentation Dots • Barlines • Clefs • Endings and Text Repeats • Key 
Signatures • Measure Expressions • Measure Numbers • Repeat Bars • Rests • Staff 
Name • Stems; Select • Ties • Time Signatures. These checkboxes specify which musical 
elements will appear in this staff. For example, you probably wouldn’t want measure numbers 
to appear in both staves of a piano part; to omit them from the bass-clef staff, you’d deselect 
the Measure Numbers checkbox. Click the Select button to the right of the Stem Check box to 
customize your stem settings. See STAFF STEM SETTINGS DIALOG BOX. 

Tip: If you don’t want barlines to appear in a particular measure in all the staves in your piece, 
select the “Invisible” barline in the Measure Tool. Or, if you don’t want barlines to appear in 
your entire score, deselect Display All Barlines in Document Options-Barlines.
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• Notation Style: Standard • Percussion • Note Shapes • Tablature; Select. Choose a nota-
tion style, then click the Select button to display the dialog box for that style. See PERCUSSION 
for detailed information about setting up a percussion staff. Refer to NOTE SHAPES DIALOG 
BOX and TABLATURE STAFF ATTRIBUTES DIALOG BOX if you selected either of those options.

• OK • Cancel. Click OK (or press enter) to confirm, or Cancel to discard, the settings you’ve 
made in this dialog box and return to the score.

Staff Stem Settings dialog box
How to get there

Click the Staff Tool s, and double-click any staff. Click the Stem Settings button in the Items 

to Display subsection.

What it does
In this dialog box, specify the direction, staff offset and beam offset for stems in a staff. These set-
tings are particularly useful for TAB notation.
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• Stem Direction: Default Direction • Always Up • Always Down. Choose Default Direction 
to use the document’s default stem direction as defined in Layer options (see DOCUMENT 
OPTIONS-LAYERS). Choose Always Up to freeze all stems in the staff up. Choose Always 
down to freeze all stems in the staff down.  

• Horizontal Stem Offsets: Up Stem • Down Stem. Enter a value in the Up Stem or Down 
Stem text box to specify the horizontal gap between the notehead (or fret number) and the up 
and/or down stems in a staff. 

• Use Vertical Offset For NoteHead End of Stems • Offset from Notehead(s) • Offset from 
Staff • Up Stem • Down Stem. With Offset from Notehead selected, specify a value in the Up 
Stem or Down Stem text box to define a specific vertical gap between the notehead (or fret 
number) and the start (notehead end) of up and/or down stems in a staff. With Offset from 
Staff selected, specify a value in the Up Stem or Down Stem text box to define the absolute 
vertical position of the notehead end of up and/or down stems relative to the staff.  

• Use Vertical Offset for Beam End Of Stems (Offset From Staff) • Up Stem • Down Stem. 
Check this box, and enter a value in the Up Stem and/or Down Stem text box to define an 
absolute vertical position, relative to the staff, for the stem endpoints (beam end of the stem).  

• Units: EVPUs • Inches • Centimeters • Points • Picas • Spaces. When you enter the Staff 
Stem Settings dialog box, Units defaults to the current measurement unit selected in the Mea-
surement Units submenu of the Options Menu. If you prefer, choose a different measurement 
unit for beaming from the drop-down list.

• OK • Cancel. Click OK (or press enter) to confirm, or Cancel to discard, your stem settings 
and return to the Staff Attributes dialog box.

Position Full and Abbreviated Staff Names 
dialog boxes
How to get there
To set the global position for all full or abbreviated staff names in your score: Click the Staff Tool 

s. Choose Full Staff Name or Abbreviated Staff Name from the Set Default Name Positions 

submenu of the Staff Menu. The Position Full Staff Name--Default or Position Abbreviated Staff 
Name--Default dialog box appears.

To individually position a full or abbreviated staff name, click the Staff Tool s. Select a staff 

name handle. Choose Full Staff Name or Abbreviated Staff Name from the Position Names sub-
menu of the Staff Menu. Or, choose Edit Staff Attributes from the Staff Menu, then click the Full 
(or Abbr.) Name Position button in the Staff Attributes dialog box. Or, ctrl-shift-click a staff name 
handle. The Position Full Staff Name or Position Abbreviated Staff Name dialog box appears.

What it does
Use these dialog boxes to adjust the position of staff names in relation to the staves—either glo-
bally or staff-by staff; adjust either the full staff name or its abbreviated name. 
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Once you’re in this dialog box, you see the staff name displayed in the font and style you’ve 
selected as the initial font (using the Fonts options in the Document Options dialog box. If you’re 
setting the global staff name position, Finale shows you the longest staff name for reference.) 
Drag anywhere in the display area to move the staff name; place the name wherever you want it in 
relation to the beginning of the staff. Note that Finale measures the vertical distance from the top 
of the staff name and the top line of the staff.

• Display area. Drag in the display area to adjust the position of the names (or the individual 
staff name) relative to the staff.

• Alignment: Left • Right • Center. From this drop-down list, choose how you want staff 
names (or the individual staff name) aligned, relative to the staff. The staff name handle that 
appears in the score will be placed to the left, right or center of the name depending on the 
alignment you select. When you change the alignment of a staff name, Finale automatically 
updates the Justification drop-down list selection to match your selection. Since staff names 
are most often single line names, you would generally want the justification (the placement of 
the text within a frame) to match the alignment (used for positioning and handle placement) 
you select.
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• Distance from Staff: H: • V:. In these text boxes, you can precisely position where the handle 
for the staff names (or the individual staff name) should be placed, relative to the staff. The 
top-left corner of the staff is the point where H: and V: are both zero, so both of the coordi-
nates will almost always be negative numbers.

• Justification: Left • Right • Center • Full • Forced Full. This setting generally matches the 
Alignment setting (Left, Right or Center) for the staff name, however, it’s provided for multi-

line staff names such as trumpet 

From this drop-down list, choose how you want multi-line staff names (or individual staff 
names) justified. The longest line of text determines the width of the invisible text frame that 
surrounds staff names. Choose Left, Right, Center, Full, or Forced Full from the Justification 
submenu to select how you want the text positioned in a frame. Choose Left or Right to place 
the text on the left or right edge of the frame, or choose Center to center the text between the 
left and right edges. If you want full justification, choose Forced Full to spread the text evenly 
between the left and right edges of the frame, including the last line if it contains two or more 
words. (Choosing Full for staff names will left-justify each line, because each line is treated as 
the last line of a paragraph; choose Forced Full instead.) 

Remember that Finale will automatically update the Justification drop-down list selection 
when you choose an option from the Alignment drop-down list. 

• Expand Single Word. Expand Single Word works with the full justification commands only; 
it affects the appearance of lines of text containing only one word. It currently has no effect for 
staff names when you choose Full justification, since each line is treated like the last line of a 
paragraph. However, when Expand Single Word is selected and you choose Forced Full, 
Finale spreads the letters of single words on lines evenly between the left and right edges of 
the invisible frame. When Expand Single Word is not selected, all lines containing a single 
word are left-justified.

When Expand Single Word is selected and you choose Forced Full justification, Finale 
spreads the text evenly between the left and right edges of the frame. In lines of text contain-
ing only one word, Finale spreads the letters of that word evenly between the left and right 
edges of the frame. When Expand Single Word is not selected, all lines containing a single 
word are left-justified. 

These staff names are left-aligned (and 
left-justified).

These staff names are right aligned (and
right-justified).

Trumpet

Clarinet in A

&

&

Trumpet

Clarinet in A

&

&

I

II
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• OK • Cancel. Click OK (or press enter) to confirm the new position of the staff names, or 
click Cancel to discard any changes you made to the staff name positions. You return to the 
Staff Attributes dialog box or to the score.

Alternate Notation dialog box
How to get there

Click the Staff Tool s, and select Staff Attributes or Define Staff Styles from the Staff Menu. 

Click Select below Alternate Notation.

What it does
This command lets you fill the selected staff with one of several alternative-notation styles, such 
as slashes, measure repeats, or blank measures. Or you can edit or create staff styles with various 
alternate notation. To apply alternate notation to selected measures, use staff styles. For more 
information, see STAFF STYLES.
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• Slash Notation. Select this alternate-notation style to fill every measure with one slash per 
beat. In cut time, for example, there would be two slashes per bar. If you want a dot after the 
slash in compound meters, such as 6/8, check the Add Dots To Slashes In Compound Meters 
checkbox. Slash notation is useful for indicating that the player is to “comp,” or improvise, a 
part with an unspecified rhythm.

• Rhythmic Notation. This alternate-notation style converts every note or chord to a stemmed 
slash. All slashes are centered on the middle staff line, and all stems go down, unless you 
check the Stems Up in Rhythmic Notation checkbox. Use this form of slash notation when the 
player is to “comp” or improvise in a specific rhythm. See DOCUMENT OPTIONS-ALTERNATE 
NOTATION for changing rhythmic notation character positioning settings.

• One-Bar Repeat(s). This alternate-notation style hides whatever music is already in the mea-
sures (all layers), and displays instead the one-bar repeat symbol, indicating that the player is 
to repeat the contents of the previous measure. See STAFF STYLES to apply to only selected 
measures.

• Two-Bar Repeat(s). If you click this option, whatever music is already in a pair of measures 
(all layers) gets hidden. Instead, they’re filled with the two-bar repeat symbol, indicating that 
the player is to repeat the contents of the previous two measures. See DOCUMENT OPTIONS-
ALTERNATE NOTATION for changing the vertical positioning of the number. See STAFF 
STYLES to apply to only selected measures.

• Blank Notation. Choose this option to hide all the music in the selected staves. The advantage 
to this option is that anything attached to the notes in selected layer—such as chord symbols, 
lyrics, and so on—can remain in view. This feature opens up many notational possibilities: 
multiple chord symbols per note, lyrics beneath blank measures, and so on.

• Normal Notation. Choose this option to display the selected staff in standard music notation.

• Apply To Layer. Use this command to choose which layer you would like the alternate nota-
tion applied.

• Show Items Attached to Notes. Select this checkbox to display any items attached to notes 
such as articulations, lyrics, chords or note attached expressions.

• Show Notes in Other Layers. Select this checkbox to display all the notes in other layers 
other than the layer which has the alternate notation.

• Show Items Attached to Notes in Other Layers. This is similar to Show Items Attached to 
Notes, but it applies to the other layers, not the layer with the alternate notation.

• Stems Up In Rhythmic Notation. Select Rhythmic Notation and check this box to have 
rhythmic notation with all stems frozen up instead of stems down.

• Add Dots To Slashes In Compound Meters. Select Slash Notation and check this box to 
have a dot after the slash in compound meters, such as 6/8.

• OK • Cancel. Click OK (or press enter) to confirm, or Cancel to discard, the settings you’ve 
made in this dialog box.
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Staff Transpositions dialog box
How to get there

In the score: Click the Staff Tool s. Click the staff handle you want to set as a transposing 

instrument, then choose Edit Staff Attributes from the Staff Menu. In the Staff Attributes dialog 
box, click Transposition, then click Select.

Transcribing a MIDI file: Choose Open from the File Menu, and choose MIDI File from the List 
Files of Type drop-down list. Double-click the name of a MIDI file you want transcribed. In the 
Import MIDI File dialog box, click the Set Track-to-Staff List radio button. In the Track/Channel 
Mapping for Staves dialog box, click the topmost unassigned row of track information. Click 
Transposition.

What it does
You can define any staff in Finale to have any instrument transposition; for example, a trumpet 
staff can be notated up a whole step, yet Finale will still play back the music at concert pitch. 
While you’re working on the score, you can view the instrumental staves in either their transposed 
or concert-pitch forms.

In this dialog box, you can specify one of several common transpositions, or you can create your 
own. You can also tell Finale that it should use a different clef for this instrument when the staff is 
displayed in its transposed form. (Finale will use the normal clef you’ve specified as the First Clef 
for the untransposed staff.)

You can set up a staff to transpose chromatically, moving notes on a staff without changing the 
key signature. You can also direct Finale not to transpose the staff at all by choosing None from 
either the Key Signature or Chromatic drop-down list. The Set to Clef option lets you simply click 
on a graphic display containing all the clef choices to select a clef.
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• Key Signature. The Key Signature transposition drop-down list shows the most common 
transpositions that you might want to use. Make an appropriate selection from the choices. In 
this list, M = major, m = minor, P = Perfect, and the numbers represent intervals (for example, 
6 = sixth). Choose None to deactivate all transposition settings in this dialog box, except Set to 
Clef. Choose Other if you prefer to make your own transposition settings for less common 
instruments. If you choose Other, be sure to enter values into the Interval and Key Alter text 
boxes (see below). Finale will use these and the Set to Clef settings when transposing the staff. 

For this instrument… Choose this transposition

None Create Set to Clef transposition

A instrument (e.g. A clarinet) (A) Up m3, Add 3 flats

B flat instrument (e.g. clarinet, trumpet) (Bb) Up M2, Add 2 sharps

B flat instrument-treble   (e.g. tenor sax, bass clarinet) (Bb) Up M9, Add 2 sharps

D instrument (e.g. trumpet) (D) Down M2, Add 2 flats

E flat instrument (e.g. Eb clarinet) (Eb) Down m3, Add 3 sharps

E flat instrument (e.g. alto sax) (Eb) Up M6, Add 3 sharps

E flat instrument-treble (e.g. baritone sax) (Eb treble clef) Up M6+Octave, Add 3 
sharps
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• Simplify Key. If checked, Finale examines the key produced by a transposition and deter-
mines if an enharmonic spelling would result in fewer sharps or flats. For example, a passage 
in B Major for B flat trumpet, when unchecked, would be notated in C sharp Major (which has 
7 sharps). When checked, the passage is notated in D flat Major instead (with 5 flats). This 
checkbox is checked by default, and can be changed for each staff. See also the Preserve 
Octaves When Simplifying keys setting in DOCUMENT OPTIONS-KEY SIGNATURES.

• Interval. Enter a number for the desired degree of diatonic transposition. A positive number 
notates the part higher than the instrument’s sound, and a negative number makes it lower. A 
value of zero indicates that no transposition will take place, 1 raises the part one step (an inter-
val of a second), 2 raises it a third, and so on. Negative numbers lower the part. To lower a part 
one octave, for example, you’d enter -7.

• Key Alter. Use the Key Alter text box to tell Finale how to modify the key signature. A posi-
tive number in this text box adds sharps to the key signature (or subtracts flats), and a negative 
number subtracts sharps (or adds flats). 

• Chromatic. The Chromatic transposition drop-down list contains the same options as the Key 
Signature drop-down list, except for the key change settings. Instead, Finale will show the 
appropriate accidental on each transposed note without affecting the key signature. Choose 
None to deactivate all transposition settings in this dialog box, except Set to Clef. Choose 
Other if you prefer to make your own transposition settings for less common instruments. If 
you choose Other, the Interval dialog box appears. Finale will use the Interval settings and the 
Set to Clef settings when transposing the staff. 

F instrument    (e.g. French Horn) (F) Up P5, Add 1 sharp

G instrument     (e.g. alto flute) (G) Up P4, Add 1 flat

Instrument    (e.g. contrabass) Up Octave

Instrument    (e.g. piccolo) Down Octave

Other Create your own transposition settings

For this instrument… Choose this transposition

None Create Set to Clef transposition

A instrument   (e.g. A clarinet) (A) Up m3

B flat instrument   (e.g. clarinet, trumpet) (Bb) Up M2

B flat instrument - treble   (e.g. tenor sax, bass clarinet) (Bb treble clef) Up M9

D instrument (e.g. trumpet) (D) Down M2

E flat instrument (e.g. Eb clarinet) (Eb) Down m3

E flat instrument   (e.g. alto sax) (Eb) Up M6

E flat instrument-treble   (e.g. baritone sax) (Eb treble clef) Up M6+Octave

For this instrument… Choose this transposition
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• Set to Clef. To change the clef for a transposed staff (such as a treble clef baritone part), select 
this checkbox, then click the clef that you want displayed for the staff in its transposed form. If 
you don’t want Finale to use a different clef than the clef specified in the Staff Attributes dia-
log box, deselect Set to Clef.

Note: When Set to Clef is selected, Finale displays the selected clef regardless of any other 
clef changes in the staff (unless you have Display Score in Concert Pitch” selected in the 
Options Menu). If you want all clef changes to appear for a staff, make sure that Set to Clef is 
not selected in this dialog box, then choose the proper clef in the Staff Attributes dialog box. 

• OK • Cancel. Click Cancel to return to the Staff Attributes dialog box without changing the 
transposition settings. Click OK (or press enter) to confirm the transposition settings for the 
staff and return to the Staff Attributes dialog box. Finale selects the Transposition checkbox.

Staff Setup dialog box
How to get there

Click the Staff Tool s, then double-click a staff. Choose Other from the Staff drop-down list.

What it does
In the Staff Setup dialog box you define the number of lines in the current staff, set the length of 
barlines, the placement of rests, and the point on a staff at which Finale will flip stem direction 
automatically.

F instrument   (e.g. French Horn) (F) Up P5

G instrument   (e.g. alto flute) (G) Up P4

Instrument   (e.g. piccolo) Down Octave

Instrument   (e.g. contrabass) Up Octave

Other Create your own transposition settings

For this instrument… Choose this transposition
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• Custom Staff. When Custom Staff is selected, you can create a staff with up to 27 lines. Sim-
ply click the handles to show or hide staff lines. Finale automatically adjusts barlines to 
enclose the staff lines. The arrow indicates Finale’s reference staff line, above which you can 
add up to 11 staff lines, and below which you can add up to 15 lines. This is the line from 
which Finale infers musical information and measures the placement of items such as clefs 
and the default placement of rests.

• Staff Lines. Click Staff Lines if you want to create a staff with up to 100 lines. This value 
shows the number of staff lines that will appear in your score. The arrow indicates Finale’s 
reference staff line, which is the top staff line of the default 5-line staff. This is the line from 
which Finale infers musical information and measures the placement of items such as clefs 
and the default placement of rests. All staff lines are added below the 5-line staff. Finale auto-
matically adjusts the barlines to enclose the staff lines.
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• Reset Staff to: • Standard 5-line • 1-line with Full Barline • 1-line with Short Barline. Use 
this drop-down list to reset the staff to a standard five-line or common one-line staff (with a 
full or short barline). If you specify a single-line staff with full barline, Finale draws the bar-
line the length of a five-line staff and centers it on the selected line.

• Line Spacing. Here, enter the space between each staff line. The value you enter will auto-
matically round to an even number of EVPUs (or equivalent).

• Top Barline • Bottom Barline. These offsets allow you to extend the upper and lower parts of 
a barline beyond the outer staff lines. To lengthen or shorten the barlines, enter new values in 
the text boxes. Enter a positive value to move the endpoint up, and a negative value to move an 
endpoint down. These values default to zero, so that the barlines automatically enclose the 
staff lines.

• Units. Click the drop-down list to select the measurement unit you want Finale to under-
stand—and display—in the Settings section of this dialog box. For more information, see 
MEASUREMENT UNITS.

• Default Rest Placement: Double Whole Rests • Whole Rests • Half Rests • Other Rests. 
Enter values, in steps, for where you want Finale to place each rest. The value is measured 
from Finale’s reference staff line. Enter a positive value to move the rest higher, and a negative 
value to move the rest lower. Note that Finale displays the default whole rest at the same posi-
tion as the whole rest you enter.

• Stem Reversal. The Stem Reversal value, which is measured in lines and spaces, controls the 
point in a staff at which Finale will flip stems up or down. Enter -4 to set the center line in a 
regular 5-line staff as the point to use for flipping stems. Enter a positive value to specify a line 
above the reference line, and a negative value if you want to specify a line below the reference 
line.

• Top Repeat Dot • Bottom Repeat Dot. Use these options to control whether Finale draws 
repeat dots on any repeat bars on a custom staff. These options are selected by default so 
Finale displays both dots. If you do not like where Finale displays the dots, deselect these 
options to hide the repeat dots on the staff. If you prefer only one dot (e.g. for a tablature staff) 
then deselect either Show Top Repeat Dot or Show Bottom Repeat Dot.

• OK • Cancel. Click OK (or press enter) to save the new settings, or click Cancel to discard 
any changes you made to the settings. You return to the Staff Attributes dialog box.

Percussion Map Selection dialog box
How to get there

Click the Staff Tool s. Double-click a staff. Choose Percussion from the Notation Style drop-

down list if it’s not already selected. Click Select.

What it does
The Percussion Map Selection dialog box displays the percussion maps available in this docu-
ment. Finale’s default percussion maps (which were saved in Finale’s percussion library) appear 
in this dialog box, as well as any percussion maps you create or edit. Use this dialog box to edit, 
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create, and delete percussion maps (that can be used for any staff), and to select the current map 
that Finale will use with the current staff. 

Note: To load a percussion library, which can contain one or more predefined percussion instru-
ment maps, choose the Open Library command from the File Menu and select the library you 
want to open. To save a percussion library, choose Save Library from the File Menu. Finale saves 
all the percussion maps listed in the Percussion Map Selection dialog box into one library.

• Edit. Click a percussion map in the list, then click Edit to display the Percussion Map 
Designer dialog box, where you can modify the note definitions and change which notes are 
used for the current staff.

Note: Changes made to a percussion map apply to all staves that use that particular percussion 
map.

• Create. Click Create to create a new map. Finale displays the Percussion Map Designer dia-
log box, where you can set up the note definitions and specify which notes are used for the 
current staff.
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Note: Rather than create new maps, you may find it easier to edit the percussion maps con-
tained in Finale’s default percussion library. This library is based on percussion sounds found 
in General MIDI and generally held notation practice. (See GENERAL MIDI PERCUSSION MAP 
TABLE in the Appendix for a listing of General MIDI percussion sounds.)

• Duplicate. Click this button to create a duplicate copy of the selected percussion map. Use 
Shift-click to select an additional item and include all the items in between. Use ctrl-click to 
select only a specific additional item in the list.

• Delete. Click this button to delete the currently selected percussion map from the list. If the 
map is selected for the current staff or any other staff in the piece, you must choose an alter-
nate percussion map for those staves before you can delete the percussion map. Use Shift-
click to select an additional item and include all the items in between. Use ctrl-click to select 
only a specific additional item in the list. 

• Move Up • Move Down. Click these buttons to move the selected item or items up or down in 
the list. You can select more than one item. Use Shift-click to select an additional item and 
include all the items in between. Use ctrl-click to select only a specific additional item in the 
list.

• Select. Click the percussion map that you want to use for this staff, then click this button to 
return to the Staff Attributes dialog box. Finale will use the selected percussion map for this 
staff until you select a different map, reset the staff to standard notation, or choose another 
option from the Notation Style drop-down list in the Staff Attributes dialog box. Remember 
that Finale only remaps a particular note if you select Use Note in the Percussion Map 
Designer dialog box.

• Cancel. Click this button if you decide not to change the percussion map used by this staff. 
The percussion map selected when you entered the dialog box will be saved. All other changes 
that you made using the Edit, Create or Delete buttons are also saved.
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Percussion Map Designer dialog box
How to get there

Click the Staff Tool s. Double-click a staff handle. Select Percussion from the Notation Style 

drop-down list if it’s not already selected. Click Select. Click Edit or Create in the Percussion Map 
Selection dialog box.

What it does
Use the Percussion Map Designer dialog box to create or edit a map for percussion notation. Each 
note definition you create or edit for a percussion instrument (such as a hi-hat, bass drum, snare 
drum, and so on) has a particular notehead shape and occupies a specific space or line on the staff. 
You can also specify a MIDI note for playback that is different than the MIDI note entered in the 
score. If you’ve specified that Finale should use the note definition (Notes to Use is checked), 
Finale automatically applies these settings whenever that note is entered on the staff. For example, 
you might follow the common convention of notating hi-hat cymbals with X noteheads that 
always appear above the top line of a staff. When a note definition is in use for a note that you 
enter using Speedy Entry with MIDI, HyperScribe and Transcription Mode, or Import MIDI File, 
Finale knows to display it as an open or closed (depending on the note’s duration) X notehead 
above the top line of the staff, without any further action on your part.

If you enter notes without MIDI, Finale looks in the percussion map assigned to the staff for note 
definitions on that line or space on the staff. If you enter notes with MIDI, Finale looks at the 
MIDI note entered (MIDI Pitch), and uses that note definition. Whenever a staff is played back, 
Finale automatically refers to the MIDI Playback note to play the correct percussion sound.

To make it easy for you to set up a percussion staff, we’ve provided a Finale library that includes 
some percussion maps based on General MIDI, or on standard notation practice. You can use the 
maps as they are, or customize them for your percussion staves.
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• Map. Enter a name for the percussion map. You can use this map for any staff in your score, 
and select which notes you want to use in each particular staff.

• MIDI Pitch • Playback • Noteheads • Name. This list box displays all your note definitions 
for the current percussion map. The list always contains 128 items, numbered 0–127, which 
correspond to MIDI note numbers. These are actual MIDI notes that are used during MIDI 
entry. For example, the MIDI note numbers on a full 88-key keyboard range between 21 and 
108. In Finale, MIDI note number 60 is equivalent to C4, which is middle C. To set up a note 
definition, click the item that you want to change. For example, if the percussion sound you 
want to change is on MIDI note 35, scroll to 35 in the list and select it, then make your 
changes in the Note Definition text boxes by entering values in the text boxes or by dragging 
the handle in the Notehead display area. Each item in the list box shows the current settings 
for each note.

Note: Finale updates the selected list box item to reflect your changes.

• Note Definition: Name. Enter a name for the percussion instrument (snare drum, bass drum, 
cymbal, and so on) that the note represents. Finale doesn’t use this name in the score—it’s 
simply there for your reference.

• Note Definition: Playback Note • Listen. This text box defaults to the same MIDI note num-
ber as the item you are editing in the list box. Change the Playback note if you want to use a 
different percussion sound during playback once you’ve already set up the note definition. 
Enter a new number to specify a different MIDI note, or click the Listen button and play the 
desired note on your MIDI instrument. During playback, Finale plays the sound correspond-
ing to the MIDI note number that you entered rather than the actual pitch you entered.
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• Note Definition: Staff Position. This text box shows the line or space on the staff on which 
the notehead is placed, measured (in lines and spaces) from the first ledger line below the 
staff. Positive values place the notehead above the ledger line, and negative values place it 
below. Enter a new value or drag the handle in the notehead display area to change the note’s 
position.

• Note Definition: Closed Notehead • Select; Open Notehead • Select. Enter the character 
that you want to use for the note in the list box. Or, click Select to display the Symbol Selec-
tion dialog box, which shows all the characters in the notehead font in a graphical palette. 
Finale supports open and closed noteheads on each staff line. The type of notehead used 
depends on the duration of the note. Closed noteheads are used for quarter notes or smaller, 
and open noteheads for half or whole notes. By default, the closed and open noteheads for 
each entry in the list box use the standard quarter and half noteheads. The list box changes to 
reflect your selections.

• Note Definition: Notehead Display Area. Drag the handle up or down to raise or lower the 
noteheads. Open and closed noteheads are placed on the same line or space. Finale updates the 
Staff Position value as you drag, increasing it as you drag the handle up, and decreasing it as 
you drag the handle down. The list box item is updated to reflect your changes.

• Notes to Use: Highlighted Note. If an asterisk appears to the left of an item in the list, the set-
tings are turned “on” for the note, so the note definition will be used for the current staff. If no 
asterisk shows, the settings are turned “off” and Finale will use standard notation for any note 
on the current staff. Click this checkbox to select it if you want Finale to use the note defini-
tion for the note selected in the list box. If the checkbox is selected, click to deselect it and 
Finale will ignore the note definition for the note and display the note in standard notation.

• Notes to Use: All Notes • All Named Notes • None (Clear). Use these buttons to change the 
Notes in Use. Click All Notes to select all of the notes for use in the map. This may lead to 
numerous overlaps and should be used with caution. Click All Named Notes to select notes if 
they have a name defined for them. Click None to remove the selection for use for all of the 
notes in the map.

• Go to Note: Listen. Instead of scrolling to the note that you want to edit in the list box, click 
the Listen button and play the desired note on your MIDI instrument. Finale selects the corre-
sponding item in the list box.

• View Only Named Notes. Check this box to display in the list box only notes that have a 
defined name. Uncheck this box to display all notes in the list box.

• Done. Click this button when you’ve finished creating or editing the percussion map. You 
return to the Percussion Map Selection dialog box.

Note Shapes dialog box
How to get there

Click the Staff Tool s, and double-click a staff whose note shapes you want to modify. Select 

Note Shapes from the Notation Style drop-down list, and then click Select.
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What it does
The Special Tools Tool lets you change normal noteheads to X noteheads, diamond noteheads, 
and so on, on a case-by-case basis. There may be times, however, when you need every occur-
rence of a certain pitch to have a certain shape. “Shape-note” gospel music uses such a system, for 
example, as do many drum parts. This dialog box not only lets you specify a different note shape 
for every note of the scale, but even a different note shape for every rhythmic value for every note 
of the scale. See also STAFF STYLES.

You can also use this feature for creating rhythm part slashes by using the slash mark instead of a 
notehead (see GUITAR PARTS).

• Replace: Double Whole • Half • Quarter. Using this drop-down list, select the traditional 

notehead shape you want to change. The default notehead for Double Whole is W , for Whole 

is w , for Half is ˙ , and for Quarter (and smaller values) is œ . Bear in mind that you can specify 
a different notehead shape for each of these noteheads for each step of the scale.

• Noteheads on Scale Degree ___ • [Arrow controls]. Either type, or click the arrow controls 
to select, the scale degree number for which you want to change the selected notehead shapes. 
For example, to change every occurrence of G to an X-notehead in the key of C, enter 5 in this 
text box, since G is the fifth note of the scale.

• With This Symbol: ___ • Select. The character displayed in this text box is the alphabetic 
equivalent of the particular notehead shape you’re specifying; it appears in the system font, 
regardless of what it looks like in the music font. For example, even if you’ve selected an X 
notehead in the Maestro music font, you’ll see an upside-down question mark in this text box.
Instead of having to look up the alphabetic equivalent for the music symbol you want, simply 
click Select. Finale displays a palette containing every symbol in the music font; double-click 
the shape you want to use as the replacement notehead. When you return to the dialog box, 
Finale enters the symbol’s alphabetic system font equivalent in the text box automatically.

• Use Note Shapes. This checkbox, which only appears if you’ve chosen Note Shapes from the 
Options Menu, is the master switch for the settings you’ve made in this dialog box. When it’s 
selected, the score displays your new notehead shapes; deselect this checkbox to restore nor-
mal noteheads (until you re-select it).

• OK • Cancel. Click OK (or press enter) to confirm, or Cancel to discard, any changes in the 
note shape scheme you’ve established and return to the score (or the previous dialog box).
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Respace Staves dialog box
How to get there

Click the Staff Tool s, and select Respace Staves from the Staff Menu.

What it does
The Respace function adjusts the vertical spacing of all the staves in your document. It can either 
space them evenly, or—if your staves aren’t evenly spaced to begin with—it can preserve the gaps 
between staves, but make all gaps proportionally larger or smaller. 

• Top Staff Position: Keep Current Position. Leave this option selected if you don’t want to 
move the top staff. Since the top staff’s position (in Scroll View) is very important—it deter-
mines how far apart the systems are in Page View—you may want to leave the top staff as is.

• Top Staff Position: Set to ___. If you want to place the top staff a certain distance from the 
top of the screen, select this option and enter the distance in the text box.

• Top Staff Position: Scale to ___ %. If you want to adjust the top staff’s position by a percent-
age of its current position, select this option. For example, to place it twice as far down from 
the top of the screen, you’d enter 200 (%) in the text box. You’d usually use this option only if 
you’re also adjusting the other staves by a percentage.

• Distance Between Staves: Set to ___. This option lets you specify a fixed amount of space 
between staves in the score; in the text box, enter the distance you want between staves.

• Distance Between Staves: Scale to ___ %. If you don’t want all staves to be equidistant, but 
simply want to place them all closer together or farther apart, select this option, which pre-
serves their relative distances. For example, if you’ve created a larger-than-usual gap between 
the woodwind staves and the strings, you could enter 50% in this text box. There would still be 
extra space—but both the gap and the distances between staves within the woodwind or string 
sections would all be half as large.

• OK • Cancel. Click OK (or press enter) to confirm, or Cancel to discard, your new spacing 
settings.
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Staff Usage List dialog box
How to get there

Click the Staff Tool s. Choose Staff Usage from the Staff Menu.

What it does
Use the Staff Usage List dialog box to specify the exact vertical position of a selected staff, mea-
sured from the top of the window in Scroll View, and to verify which staves in the score will be 
affected by your positioning changes.

• Staff Usage List: Global • Special Part Extraction • Staff System (plus the current system 
number). Finale displays which staff systems will be affected when you position a staff or 
staves. Finale has three ways of displaying information in Page View. The first is the default, 
or “Global”, view. Finale can temporarily display the page formatting in two other ways: dur-
ing Special Part Extraction, and when a staff system or systems are “optimized” to remove 
resting parts. The Staff Usage List indicator lets you know whether the positioning changes 
you make affect the “Global” view, or whether they only affect the temporary formatting dur-
ing Special Part Extraction or optimization.
When “Global” appears, dragging a staff or changing its Distance From Top value will alter its 
position in every staff system in Page View, and its position in Scroll View.
When “Special Part Extraction” appears, dragging a staff or changing its Distance From Top 
value in Page View will affect its position in each staff system, but won’t change its position in 
Scroll View. Dragging a staff in Scroll View will affect the staff’s position in Scroll View, but 
won’t change its position in Page View until Special Part Extraction is turned off (no check-
mark appears next to the Special Part Extraction command in the Edit Menu).
“Staff System” (plus the current staff system number) appears when the selected staff system 
has been optimized using the Page Layout Tool. Any positioning change in Page View will 
affect the current staff system only.

• Staff Number • Prev • Next. This number shows Finale’s internal number for the current staff 
(Finale numbers staves in the order that they’re created). There is usually no reason to enter a 
different number for a staff. However, if you enter a new staff number, Finale will change the 
contents of a staff to match the contents of an existing staff (it will not change the staff’s order 
in the score). When two staves share the same ID number, their contents are identical and 
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dynamically linked, so that any change you make in one will appear in the other. Click Prev 
and Next to move through the staves. Remember that Finale numbers staves as you create 
them, so if you’ve rearranged or deleted staves, they might not be numbered sequentially in 
the score.

• Distance From Top. This number sets the distance from the top line of the staff to the top of 
the window in Scroll View. Enter a negative value (in measurement units) to adjust the vertical 
position of the staff down from the top of the window. If you enter the same number for two 
staves, Finale will superimpose the staves.
Hint: Finale uses this value as a starting point for positioning a staff; staff positions in Page 
View and printouts are also affected by any resizing you do with the Resize Tool. See REDUC-

ING/ENLARGING for more information.
• OK • Cancel. Click Cancel to return to the score without changing the staff’s position. Click 

OK (or press enter) to confirm your changes and return to the score.

Staff Styles dialog box
How to get there

Click the Staff Tool s. Choose Define Staff Styles from the Staff Menu.

What it does
Use the Staff Styles dialog box to create, edit and delete various sets of staff attributes that can be 
applied to sections of the staff. You can use staff styles to set up instrument doubling, cutaway 
scores, partial measure alternate notation, and other items.  See STAFF STYLES for more informa-
tion.
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• Available Styles • New • Delete. This drop-down list contains all the currently available staff 
styles. Select one from the list to edit or delete. You can also view the drop-down list using the 
arrows next to the list. Select New to create a new staff style. Type the new staff style name in 
the edit window.

• Copyable. Check this box to copy the staff style when the measure is copied with the Mass 
Edit Tool.

• Display in Context Menu. Check this box to have the Staff Style listed when you right-click 
a staff region.

• Remaining Settings. The remaining settings are the same as in the Staff Attributes dialog box 
except that these settings allow you to select, deselect or remain “as is” or grayed out so that 
whatever setting is already used remains unchanged. The drop-down lists have an additional 
(no change) setting as well. See STAFF ATTRIBUTES DIALOG BOX.

• OK • Cancel. Click Cancel to return to the score without making changes. Click OK (or press 
enter) to confirm your changes and return to the score.
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Apply Staff Style dialog box
How to get there

Click the Staff Tool s. Select a region. Choose Apply Staff Styles from the Staff Menu.

What it does
Use the Apply Staff Style dialog box to apply the specified staff style to the selected region. Staff 
Styles can be any combination of Staff Attributes. Files converted from older versions won’t auto-
matically have a Staff Style library to choose from, unless it already had Alternate Notation. If 
you don’t see any Staff Styles to choose from, you can load the Staff Styles library (see TO LOAD 
A STAFF STYLE LIBRARY) or create your own (see STAFF STYLES DIALOG BOX).

• Staff Styles. Select the desired staff style from the list box.

• Define. Select a staff style. Click Define to open the Staff Styles dialog box, where you can 
make changes to the selected staff style or create a new staff style. 

• OK • Cancel. Click Cancel to return to the score without making changes. Click OK (or press 
enter) to apply the selected staff style your changes and return to the score.
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Group Attributes dialog box
How to get there

To create a new group, click the Staff Tool s. Select the handles of staves to include in the 

group, then choose Add Group and Bracket from the Staff Menu. Or, ctrl-shift-click a handle of 
one of the selected staves. (Or, with no staves selected, choose Add Group and Bracket from the 
Staff Menu to set up a group containing all staves in the score.)

To edit an existing group, click the Staff Tool s. Click a group handle, then choose Edit Group 

Attributes from the Staff Menu. Or, double-click a group handle or a bracket handle. (Or, with no 
handle selected, choose Edit Group Attributes from the Staff Menu. Use the arrow controls to dis-
play the attributes of the groups in the document.)

What it does
In Finale, groups are created and edited in the Group Attributes dialog box. You can assign a staff 
to as many groups as you like, and customize how you want barlines and brackets to appear. See 
also GLOBAL STAFF ATTRIBUTES plug-in.
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• Group Name • Edit • Position; • Abbr. Group Name • Edit • Position. The full or abbrevi-
ated names you enter for the group appear in a regular text font. Click the Edit button to dis-
play the Edit Text window, where you can enter or edit the full or abbreviated group name, as 
well as set fonts and text styles. For details, see EDIT TEXT WINDOW.

By default, Finale positions group names vertically between the first and last staves in the 
group. The default positioning is used unless you explicitly change the position of a group 
name. To set individual positioning, click Position. The Position Full Group Name or Position 
Abbreviated Group Name dialog box appears. For details, see POSITION FULL AND ABBREVI-

ATED GROUP NAMES DIALOG BOXES.

• Staff • Through. These Staff drop-down lists show the names or numbers of the starting and 
ending staves for the currently displayed group. Choose a staff name or number to specify the 
starting and ending staves in a group. A group always includes the staves in between the spec-
ified staves.

• Group ID. Finale assigns a Group ID to each group, and internally identifies the group by a 
number. Use the arrow controls to display the attributes for other groups of staves.

• Staff List: Global • Special Part Extraction • Staff System (plus the current system num-
ber). Finale displays which staff systems will be affected when you change the attributes of a 
group. Finale has three ways of displaying information in Page View. The first is the default, 
or “Global”, view. Finale can temporarily display the page formatting in two other ways: dur-
ing Special Part Extraction, and when staff systems have been “optimized” to remove resting 
parts. The Staff List indicator lets you know whether the positioning changes you make affect 
the “Global” view, or whether they only affect the temporary formatting during Special Part 
Extraction or optimization.

When “Global” appears, changing a group’s attributes will alter its appearance in Scroll View. 
The changes will also appear in every staff system in Page View—unless you’re viewing a 
Special Part Extraction, or have already optimized staff systems. (If you later turn off Special 
Part Extraction or remove optimization, Finale will display the changes in Page View.)

“Special Part Extraction” appears when you display the group attributes for a selected staff in 
Page View, and Special Part Extraction is selected in the Edit Menu. Changing a group’s 
attributes in Page View will affect its appearance in every staff system—except for optimized 
staff systems—but won’t change its appearance in Scroll View.

“Staff System” (plus the current staff system number) appears when you display the group 
attributes for a selected staff in Page View, and the selected staff system has been optimized 
using the Page Layout Tool. Any change to a group’s attributes in Page View will affect the 
current staff system only.

• Draw Barlines: Only on Staves • Through Staves • Only Between Staves (Mensurstriche). 
Select Only on Staves if you want the barlines drawn only within each staff, without connect-
ing each staff with the barline; select Through Staves to draw one continuous barline passing 
through all the staves in the group. Select Only Between Staves (Mensurstriche) to draw bar-
lines between the staves, but not through the staff lines of each staff in the group.

• Show Group Name. This checkbox controls whether group names that you enter will appear 
in the score. When selected, the full and abbreviated group names appear in your score. If you 
prefer to hide the names for this group, deselect this checkbox.
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Tip: Use Show Default Group Names in the Staff Menu to control whether default, non-print-
ing group names appear in the score.

• Use Alternate Group Barline. Select this option if you want Finale to use an alternate barline 
style that you select from the Barline palette, instead of the barline style selected in the Mea-
sure Attributes dialog box. If this option is not selected, Finale uses the barline style specified 
in the Measure Attributes dialog box.
Note: You can override the barline selected for a group on a measure-by-measure basis by 
choosing Override Group Barlines in the Measure Attributes dialog box. When you choose 
this option, the barline set in the Measure Attributes dialog box will always appear, regardless 
of any alternate barline style selected in the Group Attributes dialog box. This might be used 
for the final bar in a piece. For more information, see BARLINES.

• Group Optimization: Optimize Normally • Only Remove if All Staves are Empty • Never 
Remove. These options dictate how Finale will treat the group after Optimization. Choose 
Optimize normally to disregard the group definition while optimizing. Choose Only Remove 
if All Staves are Empty to leave all staves if the group contains any notes in the system. This is 
typically used for instruments such as piano and harp that are notated on more than one staff. 
In these cases, you would ordinarily want either both staves to show, or none, but not just one. 
Choose Never Remove to always leave all staves in the group after optimization. For more 
detail on Optimization, see OPTIMIZING SYSTEMS.  

• Barline Styles. Click to choose an alternate style for the current group. Finale uses the 
selected style unless Override Group Barlines is selected in the Measure Attributes dialog box. 
This barline style is only used if Use Alternate Group Barline is selected in this dialog box. 
For a description of Custom, See MEASURE ATTRIBUTES DIALOG BOX.

• Bracket Options. When you first enter this dialog box, None is selected by default. Click to 
select the bracket style you want to use for the current group, or click None if you don’t want 
a bracket to enclose the group. If you want more than one bracket to appear for a group, create 
additional groups for the staves, then choose a different bracket style for each group. For 
details, see BRACKETS: STAVES—To create additional (nested) brackets.

• Distance from Left Edge of Staff • Vertical Adjust (Top of Bracket) • Vertical Adjust 
(Bottom of Bracket). As an alternative to entering values here to adjust positioning, you can 
drag the handles of a bracket on the score. Distance from the Left Edge of Staff is the distance 
(in measurement units) from the left edge of the grouped staves on which Finale will place the 
bracket. Enter a negative number to move the bracket to the left. Enter numbers in the Vertical 
Adjust (Top of Bracket) and Vertical Adjust (Bottom of Bracket) text boxes to tell Finale how 
far to extend the upper and lower ends of the bracket in relation to the top of the top staff and 
the bottom of the bottom staff, respectively. The default value of zero aligns the bracket ends 
evenly with the top and bottom lines of the group. A positive number moves the bracket end 
upward; a negative number moves the bracket end downward.

• Show Bracket if Group Contains Only One Staff. Select this option if you want a bracket to 
appear on a group containing only one staff, if all staves but one are “optimized out” (i.e., 
removed because the staves are resting instruments), or if you selected one staff from the 
group, then selected Special Part Extraction from the Edit Menu. This option is not selected by 
default, since brackets are generally omitted when only one staff appears in a staff system.
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• OK • Cancel. Click Cancel to return to the score without changing group settings. Click OK 
(or press enter) to confirm your settings and return to the score.

Position Full and Abbreviated Group Names 
dialog boxes
How to get there
To set the global position for all full or abbreviated group names in your score, click the Staff Tool 

s. Choose Full Group Name or Abbreviated Group Name from the Set Default Name Posi-

tions submenu of the Staff Menu. The Position Full Group Name--Default or Position Abbrevi-
ated Group Name--Default dialog box appears.

To individually position a full or abbreviated group name, click the Staff Tool s. Select a 

group handle. Choose Full Group Name or Abbreviated Group Name from the Position Names 
submenu of the Staff Menu. Or, choose Edit Group Attributes from the Staff Menu, then click the 
Group Name (or Abbr. Group Name) Position button in the Group Attributes dialog box. Or, ctrl-
shift-click a group handle. The Position Full Group Name or Position Abbreviated Group Name 
dialog box appears.

What it does
Use these dialog boxes to adjust the position of group names in relation to the group of staves—
either globally or group-by-group; adjust either the full group name or its abbreviated name. By 
default, Finale vertically centers all group names between the first and last staff in the group (the 
top line of the first staff and the bottom line of the bottom staff). A horizontal line indicates the 
center of the group.

Once you’re in this dialog box, you see the default group name displayed in the font and style 
you’ve selected as the initial font (using the Fonts options in the Document Options dialog box). 
Drag anywhere in the display area to move the group name; place the name wherever you want it 
in relation to the beginning of the staff. Note that Finale measures the vertical distance from the 
top of the group name.
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• Display area. Drag in the display area to adjust the position of the names (or the individual 
group name) relative to the staves.

• Alignment: Left • Right • Center. From this drop-down list, choose how you want “group 
names” (or the individual group name) aligned, relative to the group of staves. The group han-
dle that appears in the score will be placed on the left, right, or center of the name, depending 
on the alignment you select. When you change the alignment of a group name, Finale auto-
matically updates the Justification drop-down list selection to match your selection. Since 
group names are most often single line names, you would generally want the justification (the 
placement of the text within a frame) to match the alignment (used for positioning and handle 
placement) you select.

• H: • V:. In these text boxes, you can precisely position the handle for the group names (or the 
individual group name), relative to the group of staves. The left barline of the staves is the 
point where H: is zero, so this value will almost always be a negative number. Finale automat-
ically centers group names vertically between staves so the center is the point where V: is 
zero; the center is also indicated by the horizontal line between the staves in the display area.

• Justification: Left • Right • Center • Full • Forced Full. This setting generally matches the 
Alignment setting (Left, Right or Center) for the group name, however, it’s provided for multi-
line group names.
From this drop-down list, choose how you want multi-line group names (or individual group 
names) justified. The longest line of text determines the width of the invisible text frame that 
surrounds group names. Choose Left, Right, Center, Full, or Forced Full from the Justification 
submenu to select how you want the text positioned in a frame. Choose Left or Right to place 
the text on the left or right edge of the frame, or choose Center to center the text between the 
left and right edges. If you want full justification, choose Forced Full to spread the text evenly 
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between the left and right edges of the frame, including the last line if it contains two or more 
words. (Choosing Full for group names will left-justify each line, because each line is treated 
as the last line of a paragraph; choose Forced Full instead.) 
Remember that Finale will automatically update the Justification drop-down list selection 
when you choose an option from the Alignment drop-down list. 

• Expand Single Word. Expand Single Word works with the full justification commands only; 
it affects the appearance of lines of text containing only one word. It currently has no effect for 
group names when you choose Full justification, since each line is treated like the last line of a 
paragraph. However, when Expand Single Word is selected and you choose Forced Full, 
Finale spreads the letters of single words on lines evenly between the left and right edges of 
the invisible frame. When Expand Single Word is not selected, all lines containing a single 
word are left-justified.
When Expand Single Word is selected and you choose Forced Full justification, Finale 
spreads the text evenly between the left and right edges of the frame. In lines of text contain-
ing only one word, Finale spreads the letters of that word evenly between the left and right 
edges of the frame. When Expand Single Word is not selected, all lines containing a single 
word are left-justified.

• Cancel • OK. Click OK to confirm the new position of the group names, or click Cancel to 
discard any changes you made to the group name positions. You return to the Group Attributes 
dialog box or to the score.

Global Staff Attributes Plug-in
How to get there

Select Global Staff Attributes from the Plug-ins Menu. See PLUG-INS MENU for more information 

on plug-ins.

What it does
The Global Staff Attributes plug-in will modify Staff Attribute settings for more than one staff at a 
time. The plug-in allows the user to select the staves, Items to Display, Staff Attribute Options, set 
the Font, Style and Size of Staff Names and Group Names, as well as set Group Attribute Options.



Global Staff Attributes Plug-in 10-44      

OC

OC

ndex

Index

ext 
hapter

ext 
hapter

revious
hapter

revious
hapter
T

T

I

N
C

N
C

P
C

P
C

• [List of Staves] • [List of Groups]. Select the staves or groups you wish to be affected by any 
settings you make. Click to select one, shift click to select several at a time, ctrl-click to select 
non-sequential staves.

• Select Font. Click one of these buttons to display the Font dialog box and set the Font, Size or 
Style for Staff Names or Group Names for the selected staves. See FONT DIALOG BOX for 
more information.

• Options • Items to Display • Show Bracket if Group Contains only one Staff • Show 
Group Name. See the STAFF ATTRIBUTES DIALOG BOX and GROUP ATTRIBUTES DIALOG BOX 
for descriptions of these items.

• Apply • OK • Cancel. Click Apply to change the settings on the selected staves and continue 
to select other staves and settings. Click OK to apply your settings to the selected staves and 
return to the score. Click Cancel to return to the Score without making any changes.
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Staves
This entry contains information on adding, moving, spacing, deleting, hiding, and recovering 
staves. See also: STAFF LINES; STAFF NAMES; GROUPS; STAFF SIZE.

When selecting a staff, you can either click the staff’s handle or the body of the staff itself (to the 
right of the clef, time and key signature). Drag-enclose or shift-click to select as many staff han-
dles as you want. (You can also shift-click selected staves to remove them from the selection.)

To add or insert a single staff
• Choose Scroll View from the View Menu, if it isn’t already selected. 

• Click the Staff Tool s. The Staff Menu appears and handles appear on every staff.

• To add a new staff, choose New Staves, then click OK to add a staff below the existing 
staves. Or, in Scroll View double-click in the score where you want to add the staff. If you 
wish to use the Setup Wizard to add staves, choose New Staves (with Setup Wizard). To 
insert a new staff between two staves, select the staff handle that you want the new staff placed 
above, then choose New Staves and click OK (or, shift-double-click between the staves in 
Scroll View). Finale moves the existing staves down to make room for the new staff.

To move staves

• Click the Staff Tool s. The Staff Menu appears and handles appear on every staff.

• Select the staff or staves to be moved. 

• To move a staff or staves, drag the handle of one of the selected staves. Finale adjusts the 
staves differently, depending on whether you’re in Scroll or Page View, whether Special Part 
Extraction is selected in the Edit Menu, and whether the staff systems were optimized using 
Page Layout Tool. For details, see STAFF TOOL–SPECIAL MOUSE CLICKS.

Note: If a staff system has been optimized using the Page Layout Tool, two handles will 
appear on each staff in the optimized staff system in Page View. Drag the bottom staff handle 
to adjust the staff’s position only in the current staff system in Page View (drag the top handle 
to adjust the position of the staff in all staff systems in Page View). The position of the staff in 
Scroll View is unchanged.

To delete staves

• Click the Staff Tool s. The Staff Menu appears and handles appear on every staff.

• Select the handles of the staff or staves to be deleted. 

• To remove selected staves without adjusting the position of the remaining staves, choose 
Delete Staves from the Staff Menu, or press delete. To delete the selected staves and reposi-
tion any remaining staves, choose Delete Staves and Reposition from the Staff Menu, or press 
shift-delete. Finale deletes the selected staves, and places the top staff of the remaining staves 
in the former position of the top staff that was deleted, followed by any other staves.

• To restore the deleted staves, immediately choose Undo from the Edit Menu. 



Staves 10-46      

OC

OC

ndex

Index

ext 
hapter

ext 
hapter

revious
hapter

revious
hapter
T

T

I

N
C

N
C

P
C

P
C

To add evenly spaced staves

• Click the Staff Tool s. The Staff Menu appears.

• To add staves, choose New Staves from the Staff Menu. Or, select the staff handle you want 
the new staves to be placed above, then choose New Staves from the Staff Menu. The New 
Staves dialog box appears.

• Enter the number of new blank staves into the Number of Staves text box. 

• To place the new staves closer to or farther apart than those already in the score, enter a 
value (in measurement units) into the Topline to Topline Distance text box (the distance 
between the top lines of each added staff). You’ll usually enter a negative number, because 
you’re measuring down from the top line of the previous staff.

• Click OK. Finale adds the specified number of new blank staves below the bottom staff, or 
inserts blank staves below the top selected staff in the score, using the distance specified in the 
New Staves dialog box, and adjusting the staves below to make room for the newly inserted 
staves.

To space existing staves evenly

• Click the Staff Tool s. The Staff Menu appears.

• Choose Respace Staves from the Staff Menu. The Respace Staves dialog box appears.

• Leave Keep Current Position selected if you don’t want to move the top staff. To place the 
top staff a fixed distance from the top of the screen, click to select Top Staff Position: Set to, 
then enter the distance (in measurement units) into the Set to text box. To reposition the top 
staff by a percentage of its current position, click Top Staff Position: Scale to, then enter a per-
centage into the Scale to text box. For example, to place the staff twice as far down, enter 200 
(%) in the text box.

• To maintain a fixed distance between the remaining staves, click to select Distance 
Between Staves: Set to, and enter the distance (in measurement units) into the Set to text 
box. To place staves closer together or farther apart proportionally, click to select Distance 
Between Staves: Scale to, then enter a percentage into the Scale to text box. This will preserve 
the relative distance between each staff. For example, if you created a larger-than-usual gap 
between the woodwind staves and the strings, and you entered 50 (%) in the text box, Finale 
would make extra space, but both the gap and the distances between staves within the wood-
wind or string sections would be half as large.

• Click OK to confirm your changes and return to the score. 

To hide staves
See HIDING STAVES.

To hide (or show) staff-related items
Finale gives you staff-by-staff control over the display of such staff-associated items as measure 
numbers, clefs, repeat brackets, and so on. For example, you probably don’t need measure num-
bers to appear in both the top and bottom staves of your piano part, so you can hide the measure 
numbers on one staff. See also GLOBAL STAFF ATTRIBUTES, where you can set the staff attributes 
for a number of staves at one time.
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• Click the Staff Tool s. The Staff Menu appears.

• Select a staff handle, then choose Edit Staff Attributes from the Staff Menu. (Or, double-
click a staff handle, or a staff name handle.) Or, choose Edit Staff Attributes from the Staff 
Menu without selecting a staff. The Staff Attributes dialog box appears. To display the 
attributes of another staff, choose a staff from the Staff Attributes for drop-down list. (Or, use 
the arrow controls to select a staff from the Staff Attributes for drop-down list.)

• Change the settings in the Staff Attributes dialog box to show or hide items for the staff. 
In the Items to Display section, select or deselect as many checkboxes as you wish. For 
details, see STAFF ATTRIBUTES DIALOG BOX.

• Click OK to confirm your settings and return to the score. 

To recover deleted staves
Once you delete a staff, you can restore it by choosing Undo (as many times as necessary) from 
the Edit Menu, or choose Undo List from the Edit Menu and highlight Staff/Group delete and 
click OK. Actions done after the staff was deleted will also be undone. See UNDO for more infor-
mation.

To set the attributes for a staff
See also GLOBAL STAFF ATTRIBUTES, where you can set the staff attributes for a number of staves 
at one time.

• Click the Staff Tool s. The Staff Menu appears.

• Select a staff handle, then choose Edit Staff Attributes from the Staff Menu. (Or, double-
click a staff handle, or a staff name.) Or, choose Edit Staff Attributes from the Staff Menu 
without selecting a staff. The Staff Attributes dialog box appears. If you didn’t select a staff 
before entering this dialog box, choose a staff from the Staff Attributes for drop-down list. (Or, 
use the arrow controls to select a staff from the Staff Attributes for drop-down list.)

• Change settings in the Staff Attributes dialog box to define the staff’s characteristics. For 
details, see STAFF ATTRIBUTES DIALOG BOX.

• Click OK to confirm your settings and return to the score. 

Staff styles
Staff styles are named sets of staff attributes that can be applied to a region. Everywhere the same 
staff style is applied, the same staff attributes apply. If a staff style is changed, it changes every-
where in the document the staff style is applied. Staff styles can be used to create transpositions, 
change the number of staff lines, or the notation style for the selection region. A number of staff 
styles have already been created for you in the default file.

Note: While most staff styles can be layered on top of each other (i.e. 1-bar repeat and a saxo-
phone transposition), some styles conflict (i.e. 1-bar repeat and blank notation). Finale will alert 
you to this conflict when you apply or copy a staff style. It will not, however, warn you if you cre-
ate conflicting styles by editing a layered style.
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To create a staff style

• Click the Staff Tool s. The Staff Menu appears.

• Choose Define Staff Styles from the Staff Menu. The Staff Styles dialog box appears.

• Click New and type in the style name in the Style Name text box. 

• Select the items you wish to include in your staff style. See STAFF STYLES DIALOG BOX for 
details. Remember that a checkbox can be selected, unselected or grayed out which means to 
leave it as it is.

Tip: choose Copyable to allow the staff style to be copied with the Mass Edit Tool.

• Click OK. You return to the score ready to apply the staff style you created.

To edit a staff style

• Click the Staff Tool s. The Staff Menu appears.

• Choose Define Staff Styles from the Staff Menu. The Staff Styles dialog box appears.
• Select the staff style you wish to change from the Available Styles drop-down list. 
• Make any changes you require in the Staff Styles dialog box. 
• Click OK. Any changes you have made will be applied to the score everywhere that style is 

used.

To apply a staff style

• Click the Staff Tool s. The Staff Menu appears.

• Select the region you want to affect. See SELECTING MUSIC for hints on selecting shortcuts.
• While pressing the number or letter corresponding to the Metatool, (for example, S for 

Slash Notation) click a measure. Finale applies the staff style over the range or measures you 
selected. See the STAFF STYLE LIBRARY in the Appendix for a listing of metatool assignments 
in the default file. If you don’t know the metatool, use the steps below.

• Choose Apply Staff Styles from the Staff Menu. You can also select Apply Staff Styles from 
the contextual menu by right-clicking in the staff. The Apply Staff Style dialog box appears.

• Select the staff style you wish to apply from the drop-down list. 
• Click OK. The chosen staff style will be applied to the selected region.

To clear a staff style

• Click the Staff Tool s. The Staff Menu appears.

• Select the region you want to affect. See SELECTING MUSIC for hints on selecting shortcuts.
• Choose Clear Staff Styles from the Staff Menu. You can also select Clear Staff Styles from 

the contextual menu by right-clicking in the staff. Or press the backspace key on the keyboard. 
The staff style will be removed from the selected region.
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To delete a staff style

• Click the Staff Tool s. The Staff Menu appears.

• Choose Define Staff Styles from the Staff Menu. The Staff Styles dialog box appears.
• Select the staff style you wish to delete from the Available Styles drop-down list. 
• Click Delete. 
• Click OK. The staff style will be deleted from the list and the document.

To create a staff style metatool

• Click the Staff Tool s. The Staff Menu appears.

• Press shift and a number key or a letter. Finale displays the Apply Staff Style dialog box.

• Select the staff style you wish to assign from the drop-down list. 

• Click OK. 

To apply a staff style metatool

• Click the Staff Tool s. The Staff Menu appears.

• Select the region you want to affect. See SELECTING MUSIC for hints on selecting shortcuts.

• Press the number or letter corresponding to the Metatool you programmed. Finale 
applies the staff style over the range or measures you selected. See the STAFF STYLE LIBRARY 
in the Appendix for a listing of metatool assignments in the default file.

To load a staff style library
• From the File Menu, choose Open Library.

• Navigate to the folder containing the desired library. The default libraries are found in the 
Libraries folder in the Finale folder.

• Select the library and choose Open.

To save a staff style library
• Create only the staff styles you want to move. Delete redundant staff style if needed.

• From the File Menu, choose Save Library. The Save Library dialog box appears.

• Click Staff Styles and click OK.

• Name the library and click Save. The library is now available to load into other files.

Staff handles
Staff Tool: Staff Handles in Page View
When you click the Staff Tool in Page View, Finale automatically displays one or two handles on 
each staff. Drag the top staff handle (or single handle, if only one appears) to adjust the staff's glo-
bal position: Finale adjusts the spacing for every staff system in the piece. If Special Part Extrac-
tion is off (unchecked in the Edit Menu), Finale adjusts the position of the staff in Scroll View as 
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well. If Special Part Extraction is on (checked in the Edit Menu), Finale only adjusts the position 
of the staff in Page View, leaving the positioning of the staves in the full score untouched.

If you've optimized a staff system, two handles appear on each staff in the optimized staff system. 
Drag the bottom handle to adjust the position of the staff in the current staff system only.

Selecting Staves
You can select more than one handle at once by holding the shift key and clicking the handles. You 
can also drag-select any visible handles in Page View, selecting either all the top or all the bottom 
handles as desired. In staff systems displaying more than one handle, you will notice that drag-
selecting around several staves tends to select the top handles only. If you position the mouse 
carefully so that your selection includes just the bottom handle, you can drag-select around as 
many bottom handles as you wish.

Dragging Staves
If you're not sure which staff systems will be affected by dragging the handles, select a handle, 
then select Staff Usage from the Staff Menu to display the Staff Usage List dialog box. If you 
selected the top handle, Finale displays “Global” or “Special Part” at the top of the Staff Usage 
List dialog box. Any changes you make when “Global” appears will affect all the staff systems in 
Page View, and the placement of the staves in Scroll View as well. If “Special Part” appears, the 
changes will affect each staff system in Page View, but will not change the placement of the staves 
in Scroll View. A second handle appears below the main handle if a staff system has been opti-
mized. Select the bottom handle, then select Staff Usage from the Staff Menu to display the Staff 
Usage List dialog box. “Staff System (and the current system number)” appears at the top of the 
dialog box. Any changes you make will affect this staff system only.

Working with Staff Groups
You can remove group assignments on staves by selecting the group name handle then pressing 
the delete key. To check on the status of a staff and its grouping, ctrl-click its handle to display the 
Group Attributes dialog box. A staff can belong to more than one group. If you want to change the 
group attributes of a group, double-click on the group handle. Do not create a group on a global 
basis after the staves have been optimized because the group will not appear. First remove the 
optimization then add the group. You can add or edit groups on a system by system basis.

Grouping and Bracketing Optimized Staves
If you have optimized a staff system and wish to add a staff group to that system only, highlight 
the lower staff handles to be included in the group. Then ctrl-click on a handle or choose Add 
Group and Bracket from the Staff Menu. Notice, in the Group Attributes dialog box that appears, 
that the Staff List will be Staff System __ instead of Staff List:Global.

If you have first added a group to several systems and then optimized those staff systems and wish 
to edit the staff grouping of one system, double-click on the group handle, or highlight the handle 
and choose Edit Group Attributes from the Staff Menu. Notice, in the Group Attributes dialog box 
that appears, that the Staff List will be Staff System __ instead of Staff List:Global. Changes you 
make in this dialog box will affect the staff group of this staff system only.
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Hiding staves
If you’re interested in hiding staves to print a full score (so that empty staves are omitted from 
each system), see OPTIMIZING SYSTEMS.

If you’re interested in hiding staves temporarily, use the Hide Staves checkbox in the Staff 
Attributes dialog box. Do not delete the staves—a method of hiding staves that was used in ver-
sions earlier than 3.7. Delete staves only if you want to permanently remove them from the score.

To hide staves for editing (Scroll View only)
By hiding staves you’re not immediately editing, you can greatly reduce the time it takes for your 
computer to redraw the screen as you move around the score.When you change the position of a 
staff in a staff set, it changes positions for all staff sets.

• Click the Staff Tool s. Shift-click the staves you don’t want to hide. You can also select 

staves by drag-enclosing their handles or by choosing Select All from the Edit Menu. In any 
case, the selected staves’ handles become highlighted.

• While pressing ctrl, choose Program Staff Set from the View Menu; from the submenu, 
choose one of the Staff Sets (1 through 8). You’re programming a Staff Set that, when 
selected, will hide the non-selected staves.

• To view the new configuration of staves, choose the Staff Set you programmed from the 
submenu of the Select Staff Set command (in the View Menu). You can repeat this process 
with other configurations of staves (the other seven Staff Sets), which allows you a total of 
nine instantly available staff configurations. Finale prints all staves, however, no matter which 
ones are visible in Scroll View; to omit staves in printing, see “To hide staves for printing” 
below.

To hide staves for ossia measures or special playback
Use this method to hide staves that contain source music for ossia measures. Or, hide other staves 
that you don’t want printed; for example, staves containing notes for playback only, such as writ-
ten-out trills, turns, or doubled parts.

• Click the Staff Tool s. The Staff Menu appears.

• Select a staff, then choose Edit Staff Attributes from the Staff Menu. (Or, double-click a 
staff, a staff handle, or a staff name.) Or, choose Edit Staff Attributes from the Staff Menu 
without selecting a staff. The Staff Attributes dialog box appears. To display the attributes of 
another staff, choose a staff from the Staff Attributes for drop-down list. (Or, use the arrow 
controls to select a staff from the Staff Attributes for drop-down list.)

• Select Hide Staff in the Options section in the Staff Attributes dialog box, then click OK. 
Any staff that you hide using this method will still appear in any Staff Lists but “(hidden)” will 
appear after the staff’s name in the list.

To hide staves for printing
If your purpose is to hide empty staves when printing a full score, see OPTIMIZING SYSTEMS.

To hide staves containing music, which you may want to do if a staff contains alternate versions of 
music, or music only used for playback:
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• Click the Staff Tool s. The Staff Menu appears.

• Select a staff handle, then choose Edit Staff Attributes from the Staff Menu. (Or, double-
click a staff handle, or a staff name. Or, choose Edit Staff Attributes from the Staff Menu with-
out selecting a staff.) The Staff Attributes dialog box appears. To display the attributes of 
another staff, choose a staff from the Staff Attributes for drop-down list. (Or, use the arrow 
controls to select a staff from the Staff Attributes for drop-down list.)

• Select Hide Staff in the Options section in the Staff Attributes dialog box, then click OK. 
When this option is selected, Finale displays “(hidden)” after the name of the staff in the Staff 
Attributes for drop-down list in the Staff Attributes dialog box.

• Format and print your piece as usual. 

To play back only selected staves
See PLAYBACK-To play back selected staves.

To show hidden staves
If you’ve hidden a staff using the Hide Staves option in the Staff Attributes dialog box, Finale dis-
plays “(hidden)” after the name of the staff in the Staff Attributes for drop-down list in the Staff 
Attributes dialog box. 

• Click the Staff Tool s. The Staff Menu appears.

• Click the handle on a hidden staff, then choose Edit Staff Attributes from the Staff 
Menu. If you can’t find staff handles in your score, or if you’re not sure which staves are hid-
den, choose Edit Staff Attributes from the Staff Menu without selecting a staff. The Staff 
Attributes dialog box appears. Choose the hidden staff from the Staff Attributes for drop-down 
list, which provides a complete list of all staves in the score. (Or, use the arrow controls to 
select the hidden staff from the Staff Attributes for drop-down list.)

• Click to deselect Hide Staff in the Staff Attributes dialog box. The staff will reappear when 
you return to the score.

• Use the arrow controls to choose another hidden staff and deselect Hide Staff to display 
the staff in the score. 

• Repeat the process for every hidden staff you want displayed again, then click OK when 
you’re done. 

Staff names
You can actually specify two names for every staff in a score: a full name (such as Trumpet 1 in 
Bf), which appears in the first system of the score, and a second name (often abbreviated, such as 
Tpt. 1), which appears on all subsequent systems.

To create or edit a staff name
Finale always displays handles on each staff name you enter. If you don’t enter a staff name, but 
want all staff name handles to appear, make sure that Show Default Staff Names is selected (a 
checkmark appears next to the command) in the Staff Menu. If Show Default Staff Names is not 
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selected, no staff name handles will appear for unnamed staves. When the command is selected, 
Finale displays handles on all staff names including a staff’s default, non-printing name, which is 
enclosed in square brackets.

• Click the Staff Tool s. The Staff Menu appears.

• Ctrl-click a full or abbreviated staff name handle. The Edit Text window appears.

Note: You can also access the Edit Text window by clicking the Edit buttons for full or abbre-
viated staff names in the Staff Attributes dialog box. For more information, see STAFF 
ATTRIBUTES DIALOG BOX.

• Type a new staff name in the window, or make changes to an existing staff name. Change 
fonts and styles using Finale’s text editing; see TEXT and EDIT TEXT WINDOW for details.

• Click OK to confirm the name and return to the score. 

To reposition staff names (globally)
These instructions show you how to set the default position for all full and abbreviated staff 
names, except for those names that have been positioned individually. You can override the default 
positions on a staff-by-staff basis. See “To reposition staff names (individually).”

• Click the Staff Tool s. The Staff Menu appears.

• Choose Full Staff Names or Abbreviated Staff Names from the Set Default Name Posi-
tions submenu of the Staff Menu. The Position Full Staff Name--Default or Position Abbre-
viated Staff Name--Default dialog box appears, depending on your menu selection.

• Specify the alignment of the staff name by choosing Left, Right, or Center from the 
Alignment drop-down list. Finale automatically selects the matching setting (Left, Right or 
Center) from the Justification drop-down list. 

• Optional: Specify the justification for multi-line names by choosing Left, Right, Center, 
or Forced Full from the Justification drop-down list. You may need to change the justifica-
tion for multi-line names.

Note: choosing Full justification will currently have the same effect as choosing Left justifica-
tion, since each line is treated as the end of a paragraph.

• Drag the name in the display area to adjust its position, or enter new positioning num-
bers into the H: and V: text boxes, then click OK. In the currently-selected measurement 
units, the H: value determines the horizontal distance between the beginning of the staff name 
and the left edge of the staff. The V: value determines the vertical distance between the top of 
the staff name and the top line of the staff.

Tip: If your changes don’t appear to take effect, display the Staff Attributes dialog box and 
make sure that the Position checkbox is not selected. Or, select the staff name handles and 
press backspace.
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To reposition staff names (individually)
The instructions in  “To reposition staff names (globally).” show you how to set the position for all 
staff names at once. You also have control over the position of each individual staff name.

Tip: You can create a group for an instrument that uses two staves, then Finale will automatically 
center the group name between the two staves. For details, see GROUPS—To group staves.

• Click the Staff Tool s. The Staff Menu appears.

• Drag the handle of a full or abbreviated staff name to reposition the staff name on-
screen. 

• To specify the exact positioning of a staff name, click the staff name handle, then choose 
Full Staff Name or Abbreviated Staff Name from the Position Names submenu of the 
Staff Menu. (Or, ctrl-shift-click the staff name handle.) Finale displays the Position Full Staff 
Name or the Position Abbreviated Staff Name dialog box.

• Specify the alignment of the staff name by choosing Left, Right, or Center from the 
Alignment drop-down list. Finale automatically selects the matching setting (Left, Right or 
Center) from the Justification drop-down list.

• Optional: Specify the justification for multi-line names by choosing Left, Right, Center, 
or Forced Full from the Justification drop-down list. You may need to change the justifica-
tion for multi-line names.

Note: Choosing Full justification will currently have the same effect as choosing Left justifica-
tion, since each line is treated as the end of a paragraph.

• Drag the name in the display area to adjust its position, or enter new positioning num-
bers into the H: and V: text boxes. The H: value determines the horizontal distance between 
the beginning of the staff name and the left edge of the staff. The V: value determines the ver-
tical distance between the top of the staff name and the top line of the staff.

• Click OK when you have entered the position settings. 

Tip: To revert the position of the full or abbreviated staff name to its default position, select the 
staff name handle and press backspace. (Or, make sure that Position is not selected in the Staff 
Attributes dialog box.)

Note: You can also position an individual staff name from the Staff Attributes dialog box. 
Click the Position button for the full or abbreviated staff name to display the appropriate Posi-
tion dialog box. For information about the Position settings in the Staff Attributes dialog box, 
see STAFF ATTRIBUTES DIALOG BOX.

To set the initial font for staff names
• From the Options Menu, choose Document Options and select Fonts to set the initial font 

for new names that you create. The Fonts options appear, listing various elements for which 
you can set the default font.

• Choose Staff Names (Full) from the Text drop-down list. 

• Click the Set Font button next to the Text drop-down list. The Font dialog box appears.
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• Set the initial font, size, and style to use when creating full staff names. Click OK to con-
firm the changes.

• Repeat this process for abbreviated staff names—Choose Staff Names (Abbreviated) 
from the Text drop-down list. 

• Click OK to confirm your changes and return to the score. 

To set the font for staff names (globally)
See CHANGE FONTS and GLOBAL STAFF ATTRIBUTES.

To hide a staff name (full score)

• Click the Staff Tool s. The Staff Menu appears.

• Select a staff, then choose Edit Staff Attributes from the Staff Menu. (Or, double-click a 
staff, a staff handle, or a staff name.) Or, choose Edit Staff Attributes from the Staff Menu 
without selecting a staff. The Staff Attributes dialog box appears. To display the attributes of 
another staff, choose the staff from the Staff Attributes for drop-down list. (Or, use the arrow 
controls to select another staff.)

• In the Items to Display section, click Staff Name to deselect it, then click OK. Finale 
remembers the staff name, but hides it until you click the Staff Name checkbox again. This 
setting controls whether the staff names you enter will appear on your printed score. Default 
names enclosed in square brackets only display on-screen; they never appear on your printed 
score.

• Click OK to confirm your changes and return to the score. 

To omit and reposition staff names in extracted parts
If you want, you can tell Finale not to display the names of the staves in the extracted parts, telling 
it to place the staff name as a header on the first page or a range of pages instead. (These options 
are only available when you’re extracting parts using the Extract Parts command in the File 
Menu.)

See EXTRACTING PARTS for additional information.

• Choose Extract Parts from the File Menu. The Extract Parts dialog box appears.

• Click the Options button. The Page Options dialog box appears.

• Check Staff or Group Names (in the Items to Remove section). By selecting this checkbox, 
you’ve told Finale not to display the staff names for the staves when it extracts the part. Con-
tinue with the part extraction.

You can also use the following steps to make Finale print the staff name as a header on the first 
page (or a range of pages) of each extracted part, instead:

• Check Create Staff or Group Name Header (in the Part Names section). 
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• Specify the exact position of the staff name header by entering numbers in the H: and V: 
text boxes. These numbers specify the horizontal and vertical position of the first letter of the 
staff name header. The horizontal position is measured from the left page margin (a larger pos-
itive number moves the header further to the right on the page). The vertical position is mea-
sured from the top page margin (a larger negative number moves the header further down the 
page).

• Select Set Font to change the font, size and style of the Staff Name header. 

• Enter a value into the Resize Name to _ % text box to resize all text used in the staff 
name you plan to use as a header. The value is a percentage of the original text size; for 
example, enter 200% to double the staff name’s text size.

• In the Page__ Through__ text boxes, enter the numbers of pages on which the staff name 
header will appear. To display the header on the first page only, for example, enter 1 in the 
Page text box, and 1 in the Through text box. To display the header on every page, enter 1 in 
the Page text box, and 0 in the Through text box (or leave the Through text box blank).

• Click OK to return to the Extract Parts dialog box. 

• Make any other changes for extracting parts, then click OK. For details, see EXTRACTING 
PARTS. Finale will print the staff name in the position on the page or range of pages you spec-
ified.

Staff size
Any staff within any system can be larger or smaller than the other staves. For specific informa-
tion on creating a cue staff, see CUE NOTES. For information on staff line alterations (such as how 
many, their thickness, and their distance apart), see STAFF LINES.

To reduce or enlarge a staff
You must be in Page View to reduce or enlarge a staff.

• Click the Resize Tool w. 

• Click just to the left of the staff you want to resize or right-click on the staff and select 
Resize Staff from the contextual menu. The Resize Staff dialog box appears.

• Enter the desired reduction or enlargement percentage. Specify the region of systems 
you want to resize, and click OK. To restore the staff to normal size, click the Resize Tool, 
and then click to the left of the staff. When the dialog box appears, type 100 (%).
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Staff lines
A staff can have as many as 100 staff lines, or you can create a staff with no lines. You can also set 
the thickness of staff lines. 

If you’re interested in making the staff lines closer together or farther apart, use the Resize Tool to 
change the overall size of the music, as described in REDUCING/ENLARGING—To reduce or 
enlarge all the music on a page (or the entire piece). Once that’s done, make the notes themselves 
smaller (or larger) relative to the staff by choosing Fonts in the Document Options dialog box 
(under the Options menu), clicking the Music button, and specifying a slightly smaller (or larger) 
point size for the music font in which they’re displayed. 

To specify the number of lines for a staff

• Click the Staff Tool s, and double-click the staff handle you want to modify. The Staff 

Attributes dialog box appears. Choose Other from the Staff drop-down list.

• Select Custom from the Staff Setup dialog box. 

• Select the number and position of the staff lines in the Staff Setup window.   Click the 
handles to hide or show staff lines. 

If you want to specify just the number of staff lines, select Staff Lines and type the number of 
lines into the Staff Lines text box. See STAFF SETUP DIALOG BOX for more details.

• Click OK (or press enter) twice. 

To set the staff line thickness
• From the Options Menu, choose Document Options and select Lines and Curves. The 

Line and Curve options appear. The units are whatever you’ve selected using the Measure-
ment Units command (Options Menu). 

• Enter a new value in the Staff Lines text box. Click OK (or press enter). 

Transposing instruments
Any staff can be defined to have any instrument transposition; for example, a trumpet staff can be 
notated up a whole step, yet Finale will still play the music at concert pitch. While you’re working 
on the score, you can be looking at the instrumental staves either in their transposed or concert-
pitch forms. For steps to create a two transpositions in the same staff, such as a saxophone switch-
ing to flute for a few bars, see TO DEFINE A STAFF WITH A DOUBLE TRANSPOSITION.

To define a staff transposition

• Click the Staff Tool s, and double-click the staff handle to be transposed. The Staff 

Attributes dialog box appears.

• Select the Transposition; click Select. The Staff Transpositions dialog box appears.

• Specify the desired transposition. See STAFF TRANSPOSITION DIALOG BOX for details on set-
tings.
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• Click OK (or press enter). You return to the Staff Attributes dialog box. If there’s another 
staff for which you want to set the transposition, simply choose it from the Staff drop-down 
list at the top of the dialog box.

• Click OK (or press enter). 

To transpose a staff chromatically

• Click the Staff Tool s, click the staff handle you want to transpose, then choose Edit 

Staff Attributes from the Staff Menu (or double-click the staff). The Staff Attributes dialog 
box appears.

• Click Transposition. Click Select. The Staff Transpositions dialog box appears.

• Click Chromatic and choose the desired transposition from the drop-down list. Or 
choose Other to create your own instrument transpositions for less common instruments.

• To choose a different clef for the transposed staff, click Set to Clef to select it, then click 
the desired clef. 

• Click OK. You return to the Staff Attributes dialog box.

• Click OK to return to the score, where accidentals appear on all altered notes.

To display a score in concert pitch (or in transposed form)
Once you’ve established the transpositions for your instrumental staves as described in “To define 
a staff transposition,” above, you can tell Finale whether or not it should display the full score in 
its transposed form.

• From the Options Menu, choose Display score in concert pitch. If this option is selected, 
all music appears in its untransposed form (concert pitch) and a checkmark appears next to the 
menu item. When this option isn’t selected, any staff you’ve defined as a transposing staff will 
appear in its transposed form, just as it will when the part is extracted.

To define a staff with a double transposition
• Define the primary instrument’s transposition, as described in “To define a staff transposi-

tion,” above. Tip: If you’re using one of Coda’s templates or created your score with the Wiz-
ard, the transposition is already set correctly.

• Click the Staff Tool s. The Staff Menu appears.

• Select the region that will have the second instrument. See SELECTING MUSIC for hints on 
selecting shortcuts.

• From the Staff Menu, choose Apply Staff Styles. You can also select Apply Staff Styles 
from the contextual menu by right-clicking in the staff. The Apply Staff Style dialog box 
appears.

• Select the appropriate transposition from the drop-down list of available Staff Styles. If 
you don’t see the desired transposition, see STAFF STYLES for instructions on how to create a 
new Staff Style.

• Click OK. The transposition will be applied to the selected region. You can assign a metatool 
to a Staff Style to make applying a quicker process. See STAFF STYLES for details.
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Groups
Every staff in Finale can be assigned to one or more groups. Grouped staves have several impor-
tant characteristics. First, you can control how barlines are drawn for the staves in a group (see 
BARLINES). Second, you can add a bracket to grouped staves (see BRACKETS: STAVES). Third, 
when you’re extracting parts, the Extract Parts command gives you the option of extracting groups 
as well as staves, making it possible for pairs of staves (piano, for example) to be extracted 
together, along with a solo part.

To group staves

• Click the Staff Tool s. The Staff Menu appears.

• Select all the staves you want included in the group, then choose Add Group and Bracket 
from the Staff Menu. The Group Attributes dialog box appears.

• Select a staff from the Staff and Through drop-down lists to set the starting and ending 
staves for the group. All staves in between will also be part of the group.

• Use the settings in the Group Attributes dialog box to set the group name, bracket, and 
barline for the new group. For more information, see BARLINES, BRACKETS: STAVES, and 
GROUP ATTRIBUTES DIALOG BOX.

• Click OK to confirm your changes and return to the score. 

Note: You can also group and ungroup staves in optimized systems in Page View if you need 
to change the definition of a group on a system-by-system basis. For information on optimiz-
ing, see OPTIMIZING SYSTEMS.

To remove a group

• Click the Staff Tool s. The Staff Menu appears.

• Click a group handle to select the group. 

• Choose Remove Group from the Staff Menu, or press delete. Finale removes the group 
definition for the staves in the selected group.

To change the attributes of a group

• Click the Staff Tool s. The Staff Menu appears.

• Click a group handle, then choose Edit Group Attributes from the Staff Menu. You may 
also double-click a group handle or choose Edit Group Attributes from the Staff Menu without 
selecting a group. The Group Attributes dialog box appears. To display the attributes of 
another group, click the arrow controls to select another Group ID number.

• Use the Group Attributes dialog box to change and reposition the group name, add and 
reposition the bracket, and choose a barline style for the group barline. For details, see 
GROUP ATTRIBUTES DIALOG BOX.

• Click OK to confirm your settings and return to the score. 
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To add staves to a group

• Click the Staff Tool s. The Staff Menu appears.

• Click a group handle, then choose Edit Group Attributes from the Staff Menu. You may 
also double-click a group handle or choose Edit Group Attributes from the Staff Menu without 
selecting a group. The Group Attributes dialog box appears. To display the attributes of 
another group, click the arrow controls to select another Group ID number.

• Add staves to a group by choosing different staff names from the Staff and Through 
drop-down lists. All staves in between will also be part of the group. For details, see GROUP 
ATTRIBUTES DIALOG BOX.

• Click OK to confirm your settings and return to the score. 

To remove staves from a group
To exclude a currently grouped staff from its group, you’ll need to change the staves that are 
included in the group.

• Click the Staff Tool s. The Staff Menu appears.

• Click a group handle, then choose Edit Group Attributes from the Staff Menu. You may 
also double-click a group handle or choose Edit Group Attributes from the Staff Menu without 
selecting a group. The Group Attributes dialog box appears. To display the attributes of 
another group, click the arrow controls to select another Group ID number.

• Adjust which staves are included in a group by choosing different staff names from the 
Staff and Through drop-down lists. All staves in between will also be part of the group. For 
details, see GROUP ATTRIBUTES DIALOG BOX.

• Click OK to confirm your settings and return to the score. 

To configure a multiple-staff part to optimize like a single staff.

• Click the Staff Tool s. The Staff Menu appears.

• Click a group handle, then choose Edit Group Attributes from the Staff Menu.

• Click the drop-down menu next to Group Optimization and choose Only Remove if All 
Staves Empty.

• Click OK.  Now, when you optimize your score, Finale will only remove the staves in the 
group you selected if all staves in the group are empty. For more information on optimization, 
see OPTIMIZING SYSTEMS. 
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Group names
You can specify two names for every group in a score. For example if you’ve defined a group for a 
piano part, you can enter a full name (such as Piano), which appears in the first system of the 
score, and a second name (often abbreviated, such as Pno.), which appears on all subsequent sys-
tems.

To create or edit a group name

• Click the Staff Tool s. The Staff Menu appears.

• If you haven’t yet created the group you’re naming, do so now. For details, see GROUPS–
”To group staves”.

• Ctrl-click a group handle. The Edit Text window appears.
Note: You can also access the Edit Text window by clicking the Edit buttons for full or abbre-
viated group names in the Group Attributes dialog box. For more information, see GROUP 
ATTRIBUTES DIALOG BOX.

• Type a new group name in the window or make changes to an existing group name. 
Change fonts and styles using the Text Tool; see EDIT TEXT WINDOW for details. 

• Click OK to confirm the name and return to the score. 

Note: You can also access the Edit Text window by clicking the Edit buttons for full or abbre-
viated group names in the Group Attributes dialog box. For more information, see GROUP 
ATTRIBUTES DIALOG BOX.

To position group names (globally)
These instructions show you how to set the default position for all full and abbreviated group 
names. You can override these positions on a group-by-group and system-by-system basis, how-
ever; see “To reposition group names (individually).”

• Click the Staff Tool s. The Staff Menu appears.

• Choose Full Group Names or Abbreviated Group Names from the Set Default Name 
Positions submenu of the Staff Menu. The Position Full Group Name--Default or Position 
Abbreviated Group Name--Default dialog box appears, depending on your menu selection.

• Specify the alignment of the group name by choosing Left, Right, or Center from the 
Alignment drop-down list. Finale automatically selects the matching setting (Left, Right or 
Center) from the Justification drop-down list.

• Optional: Specify the justification for multi-line names by choosing Left, Right, Center, 
or Forced Full from the Justification drop-down list. You may need to change the justifica-
tion for multi-line names.
Note: choosing Full justification will currently have the same effect as choosing Left justifica-
tion, since each line is treated as the end of a paragraph.

• Drag the name in the display area to adjust its position, or enter values, in measurement 
units, into the H: and V: text boxes to adjust the position of the name. The H: value deter-
mines the horizontal distance between the beginning of the group name and the left edge of 
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the staff. By default, Finale vertically centers group names between the first and last staff in 
the group. A horizontal line between the staves indicates the center of the group of staves. The 
V: value determines the vertical distance of the group name from the center point.

• Click OK when you have entered the position settings. 
Tip: If your changes don’t appear to take effect, display the Group Attributes dialog box and 
make sure that the Position checkbox is not selected. Or, select the group handles and press 
backspace.

To reposition group names (individually)

• Click the Staff Tool s. The Staff Menu appears.

• Drag a group handle to reposition the full or abbreviated group name on-screen. 
• To specify the exact positioning of a group name, click a group handle, then choose Full 

Group Name or Abbreviated Group Name from the Position Names submenu of the 
Staff Menu. (Or, ctrl-shift-click a group handle.) The Position Full Group Name or the Posi-
tion Abbreviated Group Name dialog box appears.

• Specify the alignment of the group name by choosing Left, Right, or Center from the 
Alignment drop-down list. Finale automatically selects the matching setting (Left, Right or 
Center) from the Justification drop-down list.

• Optional: Specify the justification for multi-line names by choosing Left, Right, Center, 
or Forced Full from the Justification drop-down list. You may need to change the justifica-
tion for multi-line names.

Note: choosing Full justification will currently have the same effect as choosing Left justifica-
tion, since each line is treated as the end of a paragraph. 

• Drag the name in the display area to adjust its position, or enter values, in measurement 
units, into the H: and V: text boxes to adjust the position of the group name. The H: value 
determines the horizontal distance between the beginning of the group name and the left edge 
of the staff. By default, Finale vertically centers group names between the first and last staff in 
the group. A horizontal line between the staves indicates the center of the group of staves. The 
V: value determines the vertical distance of the group name from the center point.

• Click OK when you have entered the position settings. 

Tip: To revert the position of the full or abbreviated group name to its default position, select 
the group handle and press backspace. (Or, make sure that Position is not selected in the 
Group Attributes dialog box.)

Note: You can also position an individual group name from the Group Attributes dialog box. 
Click a group handle, then choose Edit Group Attributes from the Staff Menu, or double-click 
a group handle. The Group Attributes dialog box appears. Click the Position button for the full 
or abbreviated group name to display the appropriate Position dialog box. For information 
about the Position settings in the Group Attributes dialog box, see GROUP ATTRIBUTES DIA-

LOG BOX.
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To set the initial font for group names
• From the Options Menu, choose document options and select Fonts to set the initial font 

for new names that you create. The Fonts options appear, listing various elements for which 
you can set the font.

• Choose Group Names (Full) from the Text drop-down list. 

• Click the Set Font button next to the Text drop-down list. The Font dialog box appears.

• Set the initial font, size, and style to use when creating full group names. Click OK twice 
to confirm the changes and return to the score.

• Repeat this process for abbreviated group names—choose Group Names (Abbreviated) 
from the Text drop-down list. 

• Click OK to confirm your changes and return to the score. 

To change the font for group names (globally)
See CHANGE FONTS and GLOBAL STAFF ATTRIBUTES.

To hide a group name (full score)

• Click the Staff Tool s. The Staff Menu appears.

• Click a group handle, then choose Edit Group Attributes from the Staff Menu. (Or, dou-
ble-click a group handle.) To display the attributes of another group, use the arrow controls to 
change the Group ID number.

• Deselect the Show Group Name checkbox, then click OK. Finale remembers the group 
name, but hides it until you select the Show Group Name checkbox again. This setting con-
trols whether the group names you enter will appear on your printed score. Default names 
enclosed in square brackets only display on-screen; they never appear on your printed score.

• Click OK to confirm your changes and return to the score. 

To omit and reposition group names in extracted parts
If you want, you can tell Finale not to display the group names in the extracted parts, telling it to 
place the group name as a header on the first page or a range of pages instead. (These options are 
only available when you’re extracting parts using the Extract Parts command in the File Menu.)

See EXTRACTING PARTS for additional information about extracting parts.

• Choose Extract Parts from the File Menu. The Extract Parts dialog box appears.

• Click the Options button. The Page Options dialog box appears.

• Click Staff or Group Names (in the Items to Remove section). By selecting this checkbox, 
you’ve told Finale not to display the group names for the group of staves when it extracts the 
part. Continue with the part extraction.

You can also use the following steps to make Finale print the group name as a header on the 
first page, or a range of pages, of each extracted part, instead.

• Click Create Staff or Group Name Header (in the Part Names section). 
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• Specify the exact position of the group name header by entering numbers in the H: and 
V: text boxes. These numbers specify the horizontal and vertical position of the first letter of 
the group name header. The horizontal position is measured from the left page margin (a 
larger positive number moves the header further to the right on the page). The vertical position 
is measured from the top page margin (a larger negative number moves the header further 
down the page).

• Enter a value into the Resize Name to _ % text box to resize all text used in the group 
name you plan to use as a header. The value is a percentage of the original text size; for 
example, enter 200% to double the staff name’s text size.

• In the Page__ Through__ text boxes, enter the numbers of pages on which the group 
name header will appear. To display the header on the first page only, for example, enter 1 in 
the Page text box, and 1 in the Through text box. To display the header on every page, enter 1 
in the Page text box, and 0 in the Through text box (or leave the Through text box blank).

• Click OK to return to the Extract Parts dialog box. 
• Make any other changes for extracting parts, then click OK. For details, see EXTRACTING 

PARTS. Finale will print the group name in the position on the page or range of pages you 
specified.

Barlines
Use the Staff Tool and the Group Attributes dialog box to draw barlines and set alternate barlines 
(instead of the barline style selected in the Measure Attributes dialog box) for groups. Use the 
Measure Tool to set the barlines for staves, and to override the group barline setting. See also 
AUTOMATIC BARLINES.

To draw the barline on a group
Grouped staves have an important characteristic: instead of drawing barlines only on the staves, 
the barlines can either be drawn through or between staves in a group.

Make sure you’re in Scroll View before you begin; if you’re not, choose Scroll View from the 
View Menu.

• Click the Staff Tool s. The Staff Menu appears.

• If you haven’t yet created the group, do so now. See GROUPS—To group staves.

• Click a group handle, then choose Edit Group Attributes from the Staff Menu. Or, dou-
ble-click a group handle. (Or, choose Edit Group Attributes from the Staff Menu without 
selecting a group.) To display the attributes of another group, use the arrow controls to select 
another Group ID number.

• Use the Draw Barlines drop-down list in the Group Attributes dialog box to specify how 
you want barlines to appear for this group. To draw the barline only within each staff, and 
not connect each staff with the barline, choose Only on Staves from the drop-down list. To 
draw a barline as one continuous line passing through all the staves in the group, choose 
Through Staves. To draw a barline between staves, but not through the staff lines themselves, 
choose Only Between Staves (Mensurstriche).
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Hint: If Group Attributes do not appear in page view, turn off optimization. You can then re-
apply optimization as needed.

• Click OK to confirm your barline settings and return to the score. 

To break a barline between grouped staves
There are several ways to draw or break barlines between every staff in a group. If you don’t want 
to draw the barlines through any staff on a group, use the Draw Barlines drop-down list in the 
Group Attributes dialog box to specify the appearance of the barlines (see “To draw the barline on 
a group”). However, to break a barline above a single staff in a group whose barlines are otherwise 
drawn through the group of staves, follow these instructions:

• Click the Staff Tool s. The Staff Menu appears.

• Select the staff immediately below the desired break, then choose Edit Staff Attributes 
from the Staff Menu. Or, double-click a staff, staff handle, or staff name handle immediately 
below the desired break. The Staff Attributes dialog box appears.

• Click Break Barlines Between Staves, then click OK. You return to the score; the barline is 
no longer drawn continuously through the space above the staff you selected.

To create one double, dotted, final, or other barline

• Click the Measure Tool z, and double-click the handle of the barline you want to 

change. The Measure Attributes dialog box appears.

• Click the desired barline type. When you select any unusual barline type, Finale automati-
cally selects Break a Multimeasure Rest; that’s so that, when you extract parts, the special bar-
line will break a multimeasure rest (or “block rest”) into two block rests, one on each side of 
it. (Such block rests automatically break for key and time changes, clef changes, and so on.) 

• Click OK (or press enter). 

To change barlines for groups

• Click the Staff Tool s. The Staff Menu appears.

• Click a group handle, then choose Edit Group Attributes from the Staff Menu. (Or, dou-
ble-click a group handle.) Or, choose Edit Group Attributes from the Staff Menu without 
selecting a group. The Group Attributes dialog box appears. To display the attributes of 
another group, click the spin controls to select another Group ID number.

• To use an alternate barline style instead of the barline style originally defined in the 
Measure Attributes dialog box, select Use Alternate Group Barline, then select the bar-
line style from the palette for the group. 

• Click OK to return to the score. 

To change barlines in a selected region (or at regular intervals)
Using this method, you can either change all barlines in a region to a specific type (such as an 
Invisible barline), or you can change barlines at regular intervals (for example, creating a double 
barline every eight measures).
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• Click the Measure Tool z, and select the region you want to affect. See SELECTING 

MUSIC for some region-selecting shortcuts. 

• From the Measure Menu, choose Edit Measure Attributes. The Measure Attributes dialog 
box appears.

• Click to select the barline type you want. In the Change Every     Measures text box, 
enter the frequency of barlines you want to change. In other words, to create a double bar-
line every eight measures, select the double barline and enter 8 in the Change Every text box. 
(If you’re changing all barlines, leave a 1 in this text box.)

If you’re creating a part that will be extracted, you may also want to select the Break a Multi-
measure Rest checkbox (by clicking it twice), so that Finale will break bars of rest at each 
double barline.

• Click OK (or press enter). 

To hide one barline

• Click the Measure Tool z and double-click handle of the barline you want to hide. 

You’re about to hide the right-hand barline.

• Click the Invisible barline type. Click OK. 

To hide all barlines (No-barline music)
• Create the music normally (with barlines). 

• From the Options Menu, choose Document Options and select Barlines. The Barlines 
options appear.

• Click Display All Barlines so that the X disappears. Click OK. Note, however, that Finale  
“thinks” in measures, even if you’re creating scores with no barlines. Note: To hide the meter 
in such a score, see HIDING TIME SIGNATURES.

To move a barline

• Click the Measure Tool z. A handle appears on each barline.

• Drag the handle of the desired barline horizontally. The measure becomes wider or nar-
rower. If you move a barline in Page View, you don’t just change the width of the measure 
whose right barline you drag; you also increase or decrease the width of the measure to its 
right, making this a useful technique for touching up your page layout. (You can adjust all 
measures in a system except the last one with this method.)

To insert a false or custom barline
These instructions assume you want to insert a false barline in the middle of an existing measure. 
This method lets you create a barline of any thickness, size, or shape—curved, dotted, triple, or 
anything you can think up. You can also use Maestro or Engraver font characters at 24 pt for bar-
lines. The \ character is a normal barline and the alt+0241 character is a dashed barline in the 
Maestro font. The normal barline is the same in the Engraver font and the dashed line is the 
alt+0200 character.

• Click the Expression Tool y. 



Barlines 10-67      

OC

OC

ndex

Index

ext 
hapter

ext 
hapter

revious
hapter

revious
hapter
T

T

I

N
C

N
C

P
C

P
C

• Double-click the measure to which the barline will be attached. The Expression Selection 
dialog box appears.

• Proceeding through the dialog boxes, click as follows: Shape; Create; Select; Create. You 
end up in the Shape Designer. If you want to change the thickness of the barline, use the Line 
Thickness submenu of the Shape Designer Menu. You can also specify how you want a dashed 
or dotted barline to look by using the Dash options in the Shape Designer Menu.

The following instructions give measurements in points (1/72 inch). If you’ve been working in 
different units, choose Rulers and Grid from the Shape Designer Menu and select Points (with 
gridlines every 6 points).

• From the Shape Designer Menu, choose Show, then Grid. From the Shape Designer 
Menu, choose Show, then Staff Template.

• Click the Line Tool R. Begin drawing on the origin (the small white circle at point 

0,0). While pressing shift, drag in the drawing area, straight down, until the V: text box 
says -24. You’ve just drawn a vertical line (the shift key constrains your mouse to perfectly 
vertical or horizontal lines) that’s exactly the height of a staff.

• Press enter twice to exit the first two dialog boxes. You are now in the Shape Expression 
Designer dialog box. Don’t proceed all the way back to the score yet.

• Click Allow Horizontal Stretching to deselect the checkbox. You’ve just told Finale that the 
Shape Expression you’ve just created should not be allowed to stretch horizontally along with 
the measures (when Finale widens measures slightly to make them flush with the page mar-
gins).

• Click OK or Select in each dialog box to return to the score. The “barline” appears in every 
staff. Drag its handle to move it. Select its handle and press delete to remove it.

To change the thickness of barlines in a document
• From the Options Menu, choose Document Options, then select Barlines. The Barlines 

options appear.
• Enter a new value in either the Heavy Line Thickness or the Thin Line Thickness text 

box. The units are whatever you’ve most recently selected using the Measurement Units com-
mand (Options Menu). (The default value for barline thickness is 0.46 points.) Note that this 
setting does not change custom barlines.

• Click OK (or press enter). 

To correct barline display
In the process of creating your score, you may have added or dragged staves between existing 
staves. Such changes could have unexpected results, especially concerning the appearance of your 
barlines. If a barline doesn’t appear to be drawn correctly, you can usually solve the problem with 
this technique. If you keep Auto Sort Staves turned on, the barline display should save you these 
steps. See Auto Sort Staves in the STAFF MENU.

• Click the Staff Tool s. The Staff Menu appears.

• Choose Sort Staves from the Staff Menu to restore their appearance, based on the new 
staff order. 
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To create a double left barline
See LEFT BARLINES.

Brackets: Staves
You use the Staff Tool to place staff brackets (including “curly braces” on piano staves) into the 
score. Add brackets to staves by grouping the staves. Drag the top or the bottom handles of a 
bracket to stretch it, or to change its distance from the staves. To create nested brackets (one 
bracket within another), group each set of staves that you want the brackets to enclose. Staves can 
belong to more than one group. You can also create “floating” brackets, unattached to any staves 
and placed anywhere in the score, for certain modern pieces that require them.

To place a bracket on grouped staves
Finale allows you to define only one bracket for each group you create. However, if you want to 
place more than one bracket on a group, there’s an easy way to do so. See “To create additional 
(nested) brackets, below.” 

• Click the Staff Tool s. The Staff Menu appears.

• If you haven’t yet created the group, do so now. See GROUPS—To group staves.

• Click a group handle, then choose Edit Group Attributes from the Staff Menu. Or, dou-
ble-click a group handle. (Or, choose Edit Group Attributes from the Staff Menu without 
selecting a group.) The Group Attributes dialog box appears.To display the attributes of 
another group, click the arrow controls to select another Group ID number.

• Click one of the bracket styles in the Group Attributes dialog box to select the style you 
want to use for the group. 

• Specify the position of the bracket in relation to the group. In the Distance from Left Edge 
of Staff text box, enter the distance, in measurement units, that Finale should place the bracket 
from the left edge of the staff. A negative number moves the bracket to the left. Enter numbers 
into the Vertical Adjust (Top of Bracket) and Vertical Adjust (Bottom of Bracket) text boxes 
for the distance to extend the upper and lower ends of the bracket in relation to the top of the 
top staff and the bottom of the bottom staff, respectively. To align the bracket’s ends evenly 
with the top and bottom lines of the group, enter a value of zero. A positive number for either 
option moves the bracket’s end upward.

• Click OK to add the bracket and return to the score. 

To move or stretch a bracket

• Click the Staff Tool s. Handles appear on every group bracket in the score.

• Drag the bottom handle up or down. Drag the top handle left, right, up, or down. When 
you drag the top handle horizontally, the entire bracket moves. When you drag either handle 
vertically, you can make it appear to enclose even non-grouped staves.

• Select a bracket handle and press backspace to revert a bracket to its default length (so it 
encloses the staves of a group).
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To correct bracket display
In the course of creating a score, you may have added or dragged staves between existing staves. 
Such changes could have unexpected results, especially concerning the appearance of your brack-
ets. If a bracket doesn’t appear to be drawn correctly, you can usually solve the problem with this 
technique.

• Click the Staff Tool s. The Staff Menu appears.

• Choose Sort Staves from the Staff Menu to restore their appearance, based on the new 
staff order. 

To delete a bracket from a group

• Click the Staff Tool s. 

• To delete a bracket on-screen, click a bracket handle, then press delete. 

• Or, click a group handle, then choose Edit Group Attributes from the Staff Menu. (Or, 
double-click a group handle.) Or, choose Edit Group Attributes from the Staff Menu without 
selecting a group. The Group Attributes dialog box appears. To display the attributes of 
another group, click the spin controls to select another Group ID number.

• Select None from the Bracket palette, then click OK. Finale removes the bracket from the 
group.

To create additional (nested) brackets
Finale allows you to define only one bracket for each group using the Group Attributes dialog box. 
However, you can still place more than one bracket on staves. Simply create additional groups for 
the same staves, choosing a different bracket style for each group. This has the advantage that 
each bracket is automatically sized to match its corresponding group.

• Create a new group that contains the staves that you want the bracket to enclose, then 
choose a bracket for the new group. See “To place a bracket on grouped staves” earlier in 
this section.

To modify brackets on a system-by-system basis
You can avoid showing a bracket on a group containing a single staff, such as a solo line. If you 
don’t want a bracket to appear, make sure that Show Bracket If Group Only Contains One Staff is 
not selected in the Group Attributes dialog box.

However, there may be situations where you need the bracket configuration to change from one 
staff system to another. If you optimize the system (remove any empty staves), you’ll find that you 
can use the Staff Tool in Page View to rearrange and re-bracket the staves on a system-by-system 
basis. For details on staff optimization, see OPTIMIZING SYSTEMS.
• Choose Page View from the View Menu. Two handles appear on staves that have been opti-

mized. 

• Drag to adjust the bracket for the staff system. Or, double-click the group handle for that 
staff system that you want to change, change the bracket as needed, then click OK. (For 
instructions, see GROUPS—To group staves, and “To place a bracket on grouped staves,” 
above). Any changes you make will appear only in the single, optimized, staff system.
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To create “floating” brackets
A “floating” bracket is unattached to any particular staff; it can appear anywhere on the page. 
Finale considers such a bracket purely graphic, you can use the Expression Tool to place it.

Floating brackets can be especially useful when you need to enclose a group of lyric verses, as 
shown:

• Click the Expression Tool y. 

• Double-click on, above, or below the note to which you want to attach the bracket. The 
Expression Selection dialog box appears.  If you want the bracket to appear in more than one 
staff, be sure to select measure attached in the Expression Selection dialog box.

• Proceeding through the dialog boxes, click as follows: Shape; Create; Select; Create. You 
end up in the Shape Designer dialog box.

• Choose Bracket Style from the Shape Designer Menu, and double-click the bracket style 
you want. 

• Click the Bracket Tool Y, and then click in the drawing area. A bracket appears. To 

adjust its height or width, click the Selection (arrow) Tool, click the bracket, and drag its 
bounding handles. 

• Control-click OK or press the OK button in each dialog box until you return to the score. 
Once you’re in the score, you can stretch or move the bracket as needed (see “To move, 
stretch, or delete a floating bracket”).

To move, stretch, or delete a floating bracket
• To move or delete the bracket, click the Expression tool. Click the note or measure to 

which the bracket is attached. Its handle appears.

• Drag the handle to move the entire bracket. Click the handle and press delete to remove it. 
To stretch the bracket, double-click the handle, and drag one of the eight bounding handles 
that appear. To completely reshape the bracket, double-click it a second time, and drag its indi-
vidual control-point handles.
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Distances
You can set almost every aspect of your music’s appearance; here are a few distances and mea-
surements you can change easily.

To change the distance between staff systems
See SYSTEMS.

To change the distance between staves
• If you’re not in Scroll View, choose Scroll View from the View Menu. 

• Click the Staff Tool s. 

• Drag any staff up or down to move the staff vertically. You can drag more than one staff at 
a time if you choose several at once (by shift-clicking or by drag-enclosing their handles, so 
that they’re highlighted). If you have many staves, you can move all except one or two as fol-
lows: Choose Select All from the Edit Menu to highlight all staves’ handles. Then shift-click the 
staves you don’t want to move; when any staff is selected, a shift-click “deselects” it. Then, as 
before, drag any selected staff to move all selected staves at once.

To make all staves equidistant
After you’ve experimented with dragging staves up and down, you may want to restore them to 
even spacing. See STAVES—To space existing staves evenly.

To change the distance between staff lines

• Click the Staff Tool s, and double-click the staff handle you want to modify. The Staff 

Attributes dialog box appears. Choose Other from the Staff drop-down list.

• Select Custom from the Staff Setup dialog box.

• In the Settings section, for Line Spacing, enter the space between each staff line. Finale 
will round the number you enter to an even number of EVPUs (or equivalent). 

To change the distance between notes
The distance between the notes in each measure is determined by your choice of Allotment 
Library (see DOCUMENT OPTIONS-MUSIC SPACING). You can also drag individual notes horizon-
tally in one staff (see NOTE POSITIONING), and you can change the horizontal position of notes in 
all staves that fall on a certain beat (see BEAT POSITIONS).

To change clef, key, and meter distances
You can set various global distances in the Document Options dialog box. From the Options 
Menu, choose Document Options, then choose Clefs, Keys or Time from the list on the left. You 
will see the options on the right. Now, set the value for Space Before _ , or Space After _ to 
change the distance between the clef, key or time signature and the barline. The units are whatever 
you’ve selected using the Measurement Units command. Any measurement up or to the right are 
positive numbers; measurements down or to the left are negative.

For a more complete discussion of these options, see DOCUMENT OPTIONS-CLEFS, DOCUMENT 
OPTIONS-KEY SIGNATURES, or DOCUMENT OPTIONS-TIME SIGNATURES.
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To change the page and system margins
See MARGINS; SYSTEMS.

Percussion
Percussion Maps
Finale’s percussion notation offers a great deal of flexibility and control, especially if you take 
advantage of creating and reusing percussion maps. Finale allows you to use one map for a whole 
ensemble and turn on only the instruments you need on each staff as necessary.

Percussion staves within Finale are special in that they automatically ignore key signatures and 
transpositions. Also, if you enter a note and Finale does not find a match “in use” in that staff, that 
note will appear on the staff in its usual position as if it were in treble clef.

If you find that Finale doesn’t appear to use the percussion map that you selected, edit the map in 
the Percussion Map Designer dialog box, and make sure that Notes to Use is selected for the 
actual notes that you're entering and would like displayed on a particular staff. (Scroll through the 
list and click on the note that you want to use, then check the Notes to Use section to make sure 
that Highlighted Note is selected.)

If Finale displays your percussion notes with the wrong noteheads and you’re sure the percussion 
map is set up properly, confirm the Notehead Font settings in the Staff Attributes dialog box. 
(Make sure that the correct notehead font is in use for the staff, and that the Notehead Font check-
box is selected.)

Important! Finale will not use the note definition (the new notehead and position on the staff) 
unless Notes to Use is selected for the particular note you’re entering. Review the settings in the 
Percussion Map Designer for the map selected for the percussion staff. This is the step that is most 
commonly forgotten when constructing or selecting note definitions for a percussion staff.

Note Entry
In standard notation, percussion staves are non-pitched. However, some of Finale’s methods of 
note entry depend entirely on pitched information. Entering notes with the HyperScribe Tool or 
the Transcription Mode, importing a MIDI file, and using Speedy Entry Tool’s MIDI Input all rely 
on pitched information; Finale can automatically assign pitched MIDI notes to the desired lines 
and spaces.

You can also enter notes using the Simple Entry Tool. This method enters non-pitched notes 
directly on a percussion staff, automatically assigning the correct notehead from those “in use” in 
the staff on that position. If more than one notehead shares the same staff position (the ride cym-
bal and first tom-tom, for example), Finale will pick the first notehead it sees assigned to that posi-
tion. You can then switch between all available noteheads by “sharping” or “flatting” the note with 
Simple Entry’s alteration tools (Half Step Up, Half Step Down, Sharp, and Flat). This allows 
Finale to cycle through all available noteheads.

Percussion Library
We include many percussion maps in the library. Their purpose is to get you started and to provide 
maps for some common approaches to notating percussion staves. Although users notate percus-
sion in many different ways, Finale’s libraries are based on one increasingly accepted standard.
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However, since no single standard exists for percussion notation, you’ll probably want to create 
your own custom maps or edit Finale’s to match your needs. Once you've created the maps, save 
them into your own percussion library so that you can load them into any new file you create. Or, 
load them into the Maestro Font Default file, so the percussion maps are ready for use in new doc-
uments. For a list of the Percussion Maps included in the Percussion Library, see PERCUSSION 
MAPS under Finale Libraries in the Appendix.
The Entry maps provide most of the note definitions for a standard five tom-tom drum kit and 
other percussion instruments. Each map is configured for use with Maestro Percussion, one of 
Finale’s notehead fonts. You can also use Tamburo or any other music font for your percussion 
staff. (Choose the notehead font to use for the staff in the Staff Attributes dialog box.)

The Bass Clef Entry and Treble Clef Entry percussion maps simply provide a point of reference 
for entering notes with MIDI. Percussion notation is non-pitched, but some people find it conve-
nient to refer to the lowest of the five lines as “G” or “E”. In this way, you can easily enter pitch-
less notes by using your MIDI keyboard. Use whichever clef reference makes the most sense to 
you.

The Instrument maps include note definitions for the named instrument only. For example, Con-
gas contains note definitions for three conga notes only.

The scrolling list in the Percussion Mapping dialog box displays the MIDI Entry pitch. The Bass 
Clef maps use MIDI note 43 (G1) for the lowest of the five lines. The Treble Clef maps use MIDI 
note 64 (E3) for the lowest line. One additional map for each clef offers playback configured for 
General MIDI percussion notes.

The General MIDI Entry & Playback map is based on the percussion tones defined on notes 35 
through 81 on Channel 10 (listed in the General MIDI specification). Finale already has config-
ured all common drum set MIDI notes, leaving the remaining Latin and other instruments for you 
to customize. Refer to the GENERAL MIDI table for a list of percussion tones.

How to use Percussion Notation
The Percussion Notation feature lets you map a MIDI note entered on your MIDI keyboard, or a 
note entered without MIDI, to a defined notehead and position on a percussion staff. Notes in a 
percussion staff can also be remapped to other pitches for playback. Combined with the Staff 
Setup dialog box (also accessed from the Staff Attributes dialog box), you can now easily create 
the exact percussion staves you want in your score. You can use Finale’s Maestro Percussion font 
that contains characters sized and shaped specifically for use as percussion noteheads, or you can 
select another font, such as JazzPerc, if you prefer. 

To load a percussion library
We’ve provided a library that contains percussion maps with note definitions set to General MIDI 
percussion sounds as well as notes set up for non-MIDI use. You can either use the percussion 
maps as they are, or edit them for use with percussion staves in your score. This library has 
already been loaded into the Maestro Font Default file and the templates.
• Choose Open Library from the File Menu. 

• Locate and select the percussion library that you want to open. The percussion notation 
library included with Finale is named Percussion Maps.LIB. It is located in the Libraries 
folder in your Finale folder.
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• Click OK. Finale loads the library into the current document, then returns you to the score. 
The percussion maps contained in the library will appear in the Percussion Map Selection dia-
log box. The most recently loaded libraries appear at the bottom of the list box.

To save a percussion library
• Choose Save Library from the File Menu. 

• Click Percussion Maps. 

• Click OK. 

• Enter a file name for the percussion library, then locate and open the folder where you 
want to save your library. 

• Click OK. Finale saves the all the percussion maps in your document to the percussion 
library, then returns you to the score.

To create a percussion staff

• Click the Staff Tool s.

• Click to the left of the staff. The every measure of the staff is selected.
• From the Staff Menu, choose Apply Staff Style.
• Select Percussion (1 line or 5 line) and click OK. Any notes that appeared in the staff will be 

remapped. Any notes that you enter, with or without MIDI, will also use the percussion map. 
If more in-depth information about percussion staves, see the instructions below.

To create a percussion staff (from scratch)

• Click the Staff Tool s.

• Double-click a staff. The Staff Attributes dialog box appears.

• Near the clef display, click Select. Double-click on one of the percussion staves.

• Choose one of the three pre-defined staves from the Staff drop-down list. Choose from 
Standard 5-line, 1-line with Full Barline, 1-line with Short Barline. Or, if you’re setting up a 
custom staff, choose Other to display the Staff Setup dialog box. After you create a custom 
staff, click OK to return to the Staff Attributes dialog box. For details about setting up a cus-
tom staff, refer to STAFF SETUP DIALOG BOX.

• Under Independent Elements, click Notehead Font if it’s not already selected. The check-
box becomes selected.

• Click Select (to the right of Notehead Font). 

• Choose Maestro Percussion (or JazzPerc) 24 point as the font for percussion noteheads 
on this staff, then click OK. Or, choose an alternate font that contains all the notehead char-
acters that you want to use for percussion.

Tip: If you want to use the same notehead font for all staves in the score, it’s quicker to set the 
notehead font in Document Options-Fonts, rather than to set the notehead font individually for 
each staff in your score.
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• Choose Percussion from the Notation Style drop-down list if it’s not already selected. (To 
change a staff back to standard notation, choose Standard from the Notation Style drop-down 
list.)

• Click Select (to the right of the Notation Style drop-down list).

• Click Create if you want to create a completely new percussion map containing note def-
initions for a percussion staff. Most likely you’ll want to edit an existing map that appears in 
the list box. If so, click the percussion map, usually General MIDI Entry and Playback, that 
you want to use for the current staff, then click Edit. In either case, the Percussion Map 
Designer dialog box appears.

Tip: The Percussion Map Designer dialog box serves two functions. First, it lets you create or 
edit a percussion map which you can use on any staff in your score. Second, it lets you choose 
which notes you actually want to define for the current percussion staff.

• For each percussion sound you wish to notate, use the list on the left side to select a MIDI 
“note” used for entry. If you are using a MIDI instrument for entry, you can use the “Lis-
ten” button at the bottom of the window to select your “MIDI entry note.” Keep in mind 
that this method will reset your Playback note to the Entry note, although this can be 
corrected in the following instructions. The Note Definition section displays the settings for 
the selected note. The notes appear in order by pitch, from MIDI note 0 through MIDI note 
127.

Tip: If you intend to use MIDI for entering notes, be sure to select the MIDI note number that 
contains the percussion sound that you want to use. If you follow this rule, then you can actu-
ally HyperScribe or transcribe your music, and Finale will automatically map the note to the 
proper position and notehead character. If you don’t plan to use MIDI (when you enter notes 
with Simple Entry or Speedy Entry without MIDI), Finale simply looks for a percussion map 
on the staff position of the note that you enter, and uses the first percussion note definition it 
finds if there is more than one in use for that staff. You can cycle through all note definitions 
assigned to that line or space by using the Simple Entry tools or Speedy Entry commands that 
alter the pitch of a note.

• Enter a Playback MIDI note number in the Playback Note text box. This is the MIDI note 
used to make the playback sound. The default for this setting is the General MIDI Percussion 
Map value; see GENERAL MIDI PERCUSSION MAP TABLE. For non-General MIDI instru-
ments, see your device’s manual for these settings, or set the playback note using the “Listen” 
button.

• Enter a Staff Position, counted in steps from middle C, for your percussion notehead. 
The MIDI note you enter and the notated staff line can be different.

• Click the Select button next to Closed Notehead or Open Notehead. Finale opens the Sym-
bol selection dialog box in the Notehead font. For Closed Notehead, select the notehead you 
want to appear on quarter notes or smaller notes. For Open Notehead, select the notehead you 
want to appear on half, whole or double whole notes.
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• Click Highlighted Note in the Notes to Use section (if it's not already selected) if you 
want Finale to use this note definition on the current staff. This checkbox must be selected 
if you want the notehead, new placement and playback note to appear and sound on the staff 
according to the note definition. If this checkbox is not selected, Finale will display the note in 
standard notation.

• Continue selecting and editing notes in the list box until you've made all the changes that 
you want. Remember to select Highlighted Note in the Notes to Use section if you want each 
individual note to appear on the current staff.

Tip: Occasionally you may wish to notate more than one percussion instrument on the same 
line or space on the staff. This is easy to do in the Percussion Map Designer dialog box. Sim-
ply select different notes from the list box, change their noteheads, then drag them so they 
share the same Staff Position.

• Click Done. Finale returns you to the Percussion Map Selection dialog box.

• Click Select and OK to return to the score. Any notes that appeared in the staff will be 
remapped if Use Note was selected in the Percussion Map Designer dialog box. Any notes that 
you enter, with or without MIDI, will also use the percussion map selected for the staff. For 
percussion MIDI playback, continue with the instructions below.

• From the Window Menu, choose Instrument List.

• For percussion staves, select Channel 10, Program 1. If your playback device is not Gen-
eral MIDI, the channel and Program may be different; see your device’s manual. For more 
information, see also the INSTRUMENT LIST DIALOG BOX.

To adjust stem connections on noteheads
In order for Finale to properly attach stems to the alternate notehead shapes you use in percussion 
notation (such as X noteheads), you must turn on Stem Connections in the Stems section of the 
Document Options dialog box (under the Options menu). Stem connection settings tell Finale pre-
cisely how to attach stems to the edges of noteheads. 

• From the Options Menu, choose Document Options,  and select Stems.  Then click the  
Stem Connections button. The initial settings in the dialog box are for the Maestro font’s X 
notehead character.

• Click the notehead that you want to edit. Click Edit. 

• Select a new symbol for the notehead. Click Set Font to choose a font other than the 
Default Music Font, then click OK. For example, choose Tamburo, or any other font that 
contains noteheads. Click Select to choose a notehead character from the font you specified or 
the Default Music Font, then click Select.

• Enter new H: and V: values for the Upstem and Downstem values. 

• Click Use Stem Connections. You return to the score. Finale will now use these settings 
when it draws a stem on any of the noteheads you defined in the Stem Connections dialog box.

Tip: To turn off stem connections in a document, uncheck Use Stem Connections in the Stems 
section of the Document Options dialog box.

Refer to STEM CONNECTIONS DIALOG BOX for more details about setting stem connections.
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To enter percussion notes using Simple and Speedy Entry
When you enter notes onto a percussion staff, Finale notates them according to the settings in the 
Percussion Map Designer dialog box. Remember that only the notes for which you selected Use 
Note will be displayed according to the note’s definition in the percussion map. Other notes will 
appear in standard notation.

Occasionally you may have more than one note mapped to the same line or space on the staff. 
(See “To create a percussion staff” earlier.) If this is the case, you can use the up or down arrows 
on the Simple Entry Palette, or the plus or minus keys for Speedy Entry to cycle through the dif-
ferent noteheads.

For Simple Entry:

• Click the Simple Entry Tool 4. 

• Choose Simple Entry Palette from the Window Menu to display the palette if it doesn’t 
already appear. 

• Double-click the Half Step Up Tool ® or Half Step Down Tool √ on the Simple 

Entry Palette, then click the note you want to change. If more than one note was assigned 
to the same staff position, and is in use for the current staff (as defined in the Percussion Map 
Designer dialog box), Finale displays the next open or closed notehead for that staff position. 
Continue to click the note to cycle through all the noteheads on that position until you reach 
the notehead you want to use.

For Speedy Entry:

• Click the Speedy Entry Tool a. 

• Click the measure you want to edit. 

• Click the note you want to change. 

• Click + or - to change the notehead.

• Optional: Press the 9 key. If two percussion noteheads appear side-by-side, Finale will flip 
the position of the noteheads.

To convert standard notes to percussion

• Click the Staff Tool s.

• Double-click the percussion staff. The Staff Attributes dialog box appears.

• Check “Ignore Key Signatures” and make sure Transposition is unchecked.

• For Notation Style, choose Tablature. Click OK. The numbers now displayed on the staff 
are the MIDI “notes” that were used for entry. Use these MIDI “note” numbers to edit a per-
cussion map. For more information, see PERCUSSION MAP DESIGNER DIALOG BOX.

To import a MIDI file with a standard percussion track
To create the MIDI file, follow your sequencer’s instructions. There’s no need to quantize the 
sequence; however, you’ll probably find Finale’s quantization powers to be more effective than 
your sequencer’s. Note: Finale uses the Maestro Default File as a template when importing MIDI 
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files. If you don’t see all of your percussion maps, try loading the percussion map library into the 
Maestro Default File.

• Choose Open from the File Menu. The Open dialog box appears. The file types are listed in 
the drop-down list at the bottom of the window.

• Click MIDI File. The names of any available MIDI files appear in the list box.

• Double-click the desired document name. The Import MIDI File Options dialog box 
appears, listing various transcription options. The Track/Channel Mapping to Staves dialog 
box allows you to specify some extremely sophisticated track and channel splitting, as well as 
clefs, distances between staves, split points and multiple percussion maps. See TRACK/CHAN-

NEL MAPPING TO STAVES DIALOG BOX. Finale will choose a clef for each resultant staff based 
on the range of notes in the track. (If it discovers that the notes in a track have a very wide 
range, it will automatically notate its contents on two staves. See IMPORT MIDI FILE OPTIONS 
DIALOG BOX for details.) For most files, the default Tracks become Staves option will work 
fine.

• In the Create Percussion Staves area, click on the Select button near Percussion Map. 
The Percussion Map Selection dialog box appears. For most percussion staves, you’ll want to 
choose the General MIDI Entry and Playback. If you’re using a specific instrument, you may 
wish to select the percussion map with your instrument’s name, such as Triangle. 

• Click OK. You return to the Import MIDI File Options dialog box. In the Create Percussion 
Staves area, you can also select a different clef or playback channel for the percussion staves 
in the file. These settings will affect all percussion staves; for individual settings for more than 
one percussion staff, see TRACK/CHANNEL MAPPING TO STAVES DIALOG BOX.

• Click Quant Settings. The Quantization Settings dialog box appears.

• Click the icon representing your smallest note value. 

• Choose your quantization type. See QUANTIZATION SETTINGS DIALOG BOX for more details.

• Click More Settings. The More Quantization Settings dialog box appears.

• Select the quantization settings you desire. You can select options for grace notes and voice 
2, as well as retain key velocities and note durations. See MORE QUANTIZATION SETTINGS 
DIALOG BOX for details.

• Choose Key and Time Signature options. Most MIDI files contain key and time signature 
information already, so you usually won’t have to change the default selection (Use the File’s).

• If you’ll want to hear the sequence played back with its original tempo fluctuations and 
continuous data (controllers and wheels) data, make sure Tempo Changes and Continu-
ous Data are selected. These options capture some of the MIDI performance data from your 
sequence. For a more complete description of performance data, see Installation & Tutorials. 

• Click OK (or press enter). Finale transcribes the MIDI File into standard notation. If you dis-
cover that your settings weren’t quite right, you can close the new Finale document and try 
again—the original MIDI file is unaffected by Finale’s transcription efforts. Or, for smaller 
sectional changes, use the Retranscribe function in the Mass Edit Tool. For more information 
about the elements of the Import MIDI File Options dialog box, see IMPORT MIDI FILE 
OPTIONS DIALOG BOX and RETRANSCRIPTION.



Kodály Stick Notation and Solfège 10-79      

OC

OC

ndex

Index

ext 
hapter

ext 
hapter

revious
hapter

revious
hapter
T

T

I

N
C

N
C

P
C

P
C

Kodály Stick Notation and Solfège
The Kodály Method of music education is based on the teachings of the Hungarian composer 
Zoltan Kodály.

To use the Kodály template with Stick Notation and Solfège
• From File Menu, choose New, Document from Template.

• Navigate to the Finale folder, Templates folder, then Choral Templates. Double-click on 
Kodály. The template appears with two staves - top one for stick notation, bottom one for 
solfège.

• Use the Time Signature Tool and Key Signature Tool to set the Time Signature and Key 
Signature. Note that the key signature does not change visually on the score.

• Use the Clef Tool to set the clef for the solfège (bottom) staff. You can choose either a stan-
dard notation clef or a moveable “Do” clef. If you’re concerned with the document playing 
back correctly, make sure the “Do” clef and the Key Signature match.

• Enter your music in the solfège staff.

• Copy the music from the solfège staff to the stick notation staff with the Mass Edit Tool. 
See COPYING MUSIC. The solid noteheads will disappear, such as quarter notes or smaller. 
Only half notes and whole notes will still have noteheads.

• Click on the Articulation Tool. Move the cursor below the first stem on the stick notation 
staff until a small note appears on the cursor. This indicates that the cursor in the correct 
range to attach an articulation.

• Hold down the letter representing the Solfège pitch matching this note (D = Do, R = Re, 
M = Mi, etc.) and click the mouse. The letter appears below the stem or notehead.

• Use the Measure Tool to hide barlines, if desired. See TO HIDE ONE BARLINE.

• Optional: Click the Staff Tool, select the solfège staff. From the Staff Menu, choose 
Apply Staff Styles. Choose Note Shapes. The noteheads of the solfège staff now appear as 
shape notes.

To use the Kodály template with Auto-Stick Notation
• From File Menu, choose New, Document from Template.

• Navigate to the Finale folder, Templates folder, then Choral Templates. Double-click on 
Auto-Stick Notation. The template appears with one staff for stick notation.

• Use the Time Signature Tool and Key Signature Tool to set the Time Signature and Key 
Signature. Note that the key signature does not change visually on the score.

• Enter your music consisting of quarter note and smaller durations.

• Click the Staff Tool. Select the staff. From the Staff Menu, choose Apply Staff Styles. 
Choose Auto-Stick Notation where Do = the key you chose above. The notation you 
entered is replaced by stick notation.
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Manuscript paper
If you wish to print blank manuscript paper, without default rests, see the instructions below.

• From the File Menu, choose New, then Document with Setup Wizard. Leave Title, Com-
poser and Copyright fields blank.

• Select the desired instrumentation, then Time and Key Signature, and default font. A 
score appears.

• Click on the Text Tool. Click on the Title, Composer and Copyright text blocks and press 
Delete.

• Click on the Staff Tool. Double-click on a staff. The Staff Attributes dialog box appears.

• Uncheck Display Rests in Empty Measures. If you have more than one staff, use the Staff 
Attributes For drop-down menu to switch to the next staff. Continue unchecking Display Rests 
for all staves.

• Click OK. You return to the score.

• If desired, fine-tune the layout with the Page Layout Tool. Add additional measures with 
the Measure Tool.

• From the File Menu, choose Print. Finale prints your manuscript paper.
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